Guide to Conducting Supply Chain Assessments Using the LSAT and LIAT
The USAID | DELIVER PROJECT, Task Order 1, is funded by the U.S. Agency for International Development under contract no. GPO-I-01-06-00007-00, beginning September 29, 2006. Task Order 1 is implemented by John Snow, Inc., in collaboration with PATH; Crown Agents Consultancy, Inc.; Abt Associates; Fuel Logistics Group (Pty) Ltd.; UPS Supply Chain Solutions; The Manoff Group; and 3i Infotech. The project improves essential health commodity supply chains by strengthening logistics management information systems, streamlining distribution systems, identifying financial resources for procurement and supply chain operations, and enhancing forecasting and procurement planning. The project also encourages policymakers and donors to support logistics as a critical factor in the overall success of their health care mandates.

Recommended Citation

Abstract
Supply chain assessments are conducted periodically to support the development of logistics systems. As assessments become a standard part of overall logistics management, the capacity of in-country stakeholders to drive the assessment process needs to increase. As a guide to conducting supply chain assessments with the Logistics System Assessment Tool (LSAT) and the Logistics Indicators Assessment Tool (LIAT), this document is meant to support capacity building and supplement the lessons that evaluators have learned from their own experience.

Cover photo: District Supervisor, Mr. Mosses, reviews logistics data with a staff person during a routine monitoring and data collection activity at a dispensary in Tabora, Tanzania in 2009.
Contents

Acronyms........................................................................................................................................................................... vii
Acknowledgments ............................................................................................................................................................ ix
Overview ............................................................................................................................................................................. 1
  Background................................................................................................................................................................. 1
  Purpose ..................................................................................................................................................................... 1
  Intended Audience................................................................................................................................................ 1
  Sections in this Guide........................................................................................................................................... 2
Planning an Assessment.................................................................................................................................................... 3
  Before Conducting a Survey ...................................................................................................................................... 3
Using the LSAT................................................................................................................................................................... 9
  Planning ........................................................................................................................................................................ 9
  Data Collection ....................................................................................................................................................... 12
  Data Analysis........................................................................................................................................................ 14
  Monitoring.............................................................................................................................................................. 14
Using the LIAT ................................................................................................................................................................. 17
  Survey Design ........................................................................................................................................................ 17
  Sampling ................................................................................................................................................................. 19
  Survey Preparation ............................................................................................................................................. 29
  Data Collection Training ..................................................................................................................................... 31
  Data Collection ..................................................................................................................................................... 39
  Data Entry ........................................................................................................................................................... 39
  Data Analysis........................................................................................................................................................ 40
Presenting Results............................................................................................................................................................ 43
  Assembling Key Information .................................................................................................................................... 43
  Presenting the Results ........................................................................................................................................... 43
  Storing Data and Results for Follow-On Activities ............................................................................................ 44
Appendices
  A. Sample Activity Schedule for a Five-Week Assessment ................................................................................... 45
  B. Determining a Data Collection Method for System Assessments Using the LSAT ............................................. 47
  C. Determining Survey Design Type for Facility-Level Assessments using the LIAT ................................................... 49
  D. Determining Sampling Method for Facility-Level Assessments Using the LIAT ................................................... 51
  E. Scopes of Work for Data Analysts and Survey Coordinators (LIAT) ............................................................... 53
  F. Job Descriptions for Data Collectors and Data Entry Personnel (LIAT) ............................................................... 57
  G. Materials Needed for Survey Training and Data Collection (LIAT) ................................................................. 61
  H. LIAT Trainer’s Guide .......................................................................................................................................... 63
### Acronyms

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIS</td>
<td>HIV/AIDS Indicator Survey</td>
</tr>
<tr>
<td>DEFF</td>
<td>design effect</td>
</tr>
<tr>
<td>DHS</td>
<td>Demographic and Health Survey</td>
</tr>
<tr>
<td>FPC</td>
<td>finite population correction</td>
</tr>
<tr>
<td>GIS</td>
<td>geographic information system</td>
</tr>
<tr>
<td>GPS</td>
<td>global positioning system</td>
</tr>
<tr>
<td>HQ</td>
<td>headquarters</td>
</tr>
<tr>
<td>ICC</td>
<td>intraclass coefficient</td>
</tr>
<tr>
<td>LIAT</td>
<td>Logistics Indicator Assessment Tool</td>
</tr>
<tr>
<td>LMIS</td>
<td>logistics management information system</td>
</tr>
<tr>
<td>LSAT</td>
<td>Logistics System Assessment Tool</td>
</tr>
<tr>
<td>M&amp;E</td>
<td>monitoring and evaluation</td>
</tr>
<tr>
<td>MICS</td>
<td>Multiple Indicator Cluster Survey</td>
</tr>
<tr>
<td>MIS</td>
<td>Malaria Indicators Survey</td>
</tr>
<tr>
<td>MOH</td>
<td>Ministry of Health</td>
</tr>
<tr>
<td>MOSH</td>
<td>months of stock on hand</td>
</tr>
<tr>
<td>NGO</td>
<td>nongovernmental organization</td>
</tr>
<tr>
<td>PDA</td>
<td>personal digital assistant</td>
</tr>
<tr>
<td>RHS</td>
<td>International Reproductive Health Survey</td>
</tr>
<tr>
<td>SOP</td>
<td>standard operating procedure</td>
</tr>
<tr>
<td>SOW</td>
<td>scope of work</td>
</tr>
<tr>
<td>SPA</td>
<td>Service Provision Assessment</td>
</tr>
<tr>
<td>SPARHCS</td>
<td>Strategic Pathway to Reproductive Health Commodity Security</td>
</tr>
</tbody>
</table>
Acknowledgments

Completion of the *Guide to Conducting Supply Chain Assessments Using the LSAT and LLAT* was made possible through the technical and editorial contributions of Ethan Collins, Erika Ronnow, Jaya Chimnani, Suzy Sacher, Dana Aronovich, Andrew Inglis, Ariella Bock, Emma Stewart, Julia Byington, and Paul Crystal. In addition, Trisha Long and Mike Tracy were instrumental in developing and editing the Access database that is included in the toolkit this document accompanies.

It cannot be emphasized enough that all of these individuals are indebted to the many program stakeholders and health facility personnel throughout the developing world who have helped guarantee the success of logistics assessments conducted with support from the DELIVER project and the USAID | DELIVER PROJECT, and have added to the experiences that form the basis of this guide.
Overview

Background
Since being introduced in 2001 by the DELIVER project, the Logistics System Assessment Tool (LSAT) and Logistics Indicators Assessment Tool (LIAT) have been standard methods for conducting evaluations of health commodity supply chains in the developing world.

Most often used jointly, the LSAT is designed to facilitate a comprehensive quality assessment of the separate components that make up a logistics system, and the LIAT is used to assess how well the system is functioning; that is, whether the right quantities of the right products are available to all customers at the right time, in the right place, and in the right condition. Both tools were developed for use by ministries of health, NGOs, and other supply chain stakeholders.

This guide was written to provide details on the beginning-to-end process of conducting assessments whose results can effectively inform decision making and ultimately contribute to improved health commodity security.

Purpose
Supply chain assessments are conducted periodically to support routine management and strengthening of logistics systems. As assessments become a standard part of overall logistics management, the capacity of in-country stakeholders to lead the assessment process needs to increase. As a guide to conducting supply chain assessments with the LSAT and LIAT, this document is meant to support capacity building and supplement the lessons that evaluators have learned from their own experiences. It serves as the introduction to a toolkit that includes—

- Standard LSAT and LIAT documents.
- Monitoring and Evaluation Indicators for Assessing Logistics Systems Performance.
- Data Entry Tool and Database (Access), Data Entry Guidelines, and Double Data Entry Quality Control Tool (Excel).
- Guidelines for Collecting and Using GPS Data for Monitoring and Evaluation Exercises and download for GPS Trackmaker software.

The chapters herein focus on determining which type of assessment can best meet specific information needs and how to properly estimate the resources required for a successful assessment. They also emphasize that a better understanding of the assessment process and proper planning will save time and money and produce more useful results.

Intended Audience
This guide is a companion to the LSAT and LIAT and is intended for people who manage or conduct assessments using either tool. These may include program managers, technical advisors, personnel from various nongovernmental organizations (NGOs), and ministry of health (MOH) officials.
This guide also provides important background information to decision makers on how supply chain assessments are conducted to meet specific information needs and produce valid results. But the information presented is not necessarily targeted at decision makers, particularly because the process of using assessment results to develop recommendations and action plans is not discussed in depth.

**Sections in this Guide**

This guide is divided into four sections—

1. Planning an assessment
2. Using the LSAT
3. Using the LIAT
4. Presenting results

A variety of supplemental information, model materials, and other tools are provided in the appendices of this guide, as well as in the larger toolkit mentioned above.

Adaptable MSWord versions of the appendices are available here: http://www.deliver.jsi.com/dlvr_content/resources/allpubs/guidelines/Guid_Asse_Temp.doc
Planning an Assessment

Supply chain assessments are carried out for a number of reasons, including—

- Determining, as part of a pilot test, whether the commodity needs of a new program can be met reliably.
- Identifying logistics problems related to a particular product category, such as family planning commodities or products used to prevent, diagnose, and treat malaria.
- Tracking logistics performance over the course of a program.
- Understanding how program changes—such as implementation of a campaign to increase service demand—affect the supply chain.
- Improving supply chain performance and, ultimately, customer service.

Before Conducting a Survey

Determining whether an assessment is appropriate and feasible depends on when the assessment is being conducted; the availability of adequate financial, human, and material resources; whether similar information can be obtained from already-existing sources; and stakeholder agreement.

When should an assessment be conducted?

Supply chain assessments are as important for measuring changes in logistics system performance as they are for program planning. They should ideally be conducted at the beginning, mid-term, and end of a program cycle as a way to track the success of interventions and identify issues.

Many programs choose to conduct only end-of-program cycle surveys. Yet, without robust data captured at the beginning of an intervention, the amount of useful information from a stand-alone, end-line survey will be more limited, and the results will be more open to misinterpretation.

Mid-term assessments can be conducted once or at select intervals during the life of a program cycle to help determine which program interventions are successful and which may need to be changed or better targeted. Whenever possible, results from mid-term assessments should be available to inform each phase of work planning and budgeting.

The timing of assessments should also take into consideration other major logistics work that could be informed by survey results. This includes forecasting and system design workshops at the country level and the submission of key status reports by technical assistance providers.

Are the LSAT and LIAT always used jointly?

As suggested in the Overview, the combined effect of conducting a survey with the LSAT and LIAT is an understanding of how well a logistics system is structured and how efficient it is in facilitating the availability of commodities. Although both tools are ideally used to form a complete picture of the supply chain, a number of factors may influence the use of only one.
A well-functioning logistics management information system (LMIS) will often produce much of the same data on commodity availability and products flows that could be gained from an assessment in which the LIAT is used. Stakeholders with only limited funds for conducting evaluations may choose to analyze LMIS data instead of conducting a facility-based survey as a cost-savings measure. It is important to note, though, that such a decision assumes the LMIS contains accurate information from all facilities in a system. For its part, the LIAT is not only used to collect data on product availability, but also to support these findings. The LIAT helps determine:

- when stockouts have occurred, as well as how long they lasted;
- how well LMIS reporting requirements are being met;
- what logistics training and supervision facility staff have received;
- whether storage conditions are sufficient to ensure the quality of commodities; and
- whether LMIS records are being maintained routinely and accurately.

When only the LSAT is used for an evaluation, it is usually advisable for assessors to conduct a limited number of site visits to accumulate anecdotal evidence that supports the conclusions they reach using the LSAT.

Similarly, LIAT-only assessments can be done when there is confidence that the logistics system is functioning and well organized, or simply because stakeholders are primarily interested in knowing about the use of logistics management systems and product availability.

**What resources are needed?**

The scope of an assessment depends largely on the resources that are available. All relevant stakeholders should develop and approve accurate budget estimates beforehand to better ensure that intended objectives are met. Additionally, it is necessary to recruit personnel who will commit to participating throughout the length of the survey. It is therefore important to understand the amount of time that will be needed to organize an assessment, train data collectors, collect data, enter data into a database, analyze data, debrief stakeholders, and write a final technical report. A detailed activity schedule for a five-week assessment using both the LSAT and LIAT is provided in Appendix 1. The activity schedule can be summarized as follows:

**Week 1**
- Implementation of the system assessment (LSAT)
- Analysis of results from the system assessment (LSAT)

**Week 2**
- LIAT training (LIAT)

**Weeks 3 and 4**
- Data collection and data entry for the facility-level assessment (LIAT)

**Week 5**
- Analysis of results from the facility-level assessment (LIAT)
- Presentation of preliminary results from the system assessment and facility-level assessment (LSAT and LIAT)
As shown in Figure 1, all assessments entail a certain number of required costs and can also include a number of supplementary elements. When the LIAT and LSAT are used concurrently, some cost items may be paired to produce cost savings, such as international travel costs for external technical assistance. It is also important to remember that unforeseen costs almost always arise in assessments of any type, so a contingency fund should be planned in addition to the base budget.

Because the scope and coverage of supply chain assessments can vary widely, it is difficult to define a typical cost for conducting surveys with the LSAT and LIAT. Recent facility-level assessments (LIAT) supported by the USAID | DELIVER PROJECT have generally required total costs of around US$100,000. This estimation reflects data collection in 80 to 100 facilities and includes external technical assistance. Costs would be lower for programs employing only local human resources. The latest system assessments (LSAT) conducted by the project have cost approximately U.S. $25,000.

**Figure 1. Costs Associated with Surveys Using the LSAT and LIAT**

<table>
<thead>
<tr>
<th>REQUIRED</th>
<th>SUPPLEMENTARY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Facility-level Assessment (LIAT)</td>
<td>System Assessment (LSAT)</td>
</tr>
<tr>
<td>• Activity materials.</td>
<td>• Activity materials.</td>
</tr>
<tr>
<td>• Meeting venue, including lunch and coffee breaks.</td>
<td>• Meeting venue, including lunch and coffee breaks.</td>
</tr>
<tr>
<td>• Training venue, including lunch and coffee breaks.</td>
<td>• Training venue, including lunch and coffee breaks.</td>
</tr>
<tr>
<td>• Accommodation, per diem, and transportation for training participants.</td>
<td>• Accommodation, per diem, and transportation for training participants.</td>
</tr>
<tr>
<td>• Transportation for data collection, monitoring, or supervision field visits.</td>
<td>• Transportation for data collection, monitoring, or supervision field visits.</td>
</tr>
<tr>
<td>• Accommodation and per diem for data collectors and monitors.</td>
<td>• Accommodation and per diem for data collectors and monitors.</td>
</tr>
<tr>
<td>• Per diem and transportation for participants.</td>
<td>• Per diem and transportation for participants.</td>
</tr>
<tr>
<td>• Travel, per diem, and salary for a short-term technical assistance provider.</td>
<td>• Travel, per diem, and salary for a short-term technical assistance provider.</td>
</tr>
<tr>
<td>• Advertising for survey coordinator, data collectors, and data entry personnel.</td>
<td>• Advertising for survey coordinator, data collectors, and data entry personnel.</td>
</tr>
<tr>
<td>• Contracts with survey coordinator and data entry personnel, as appropriate.</td>
<td>• Contracts with survey coordinator and data entry personnel, as appropriate.</td>
</tr>
<tr>
<td>• Travel, per diem, and salary for a short-term technical assistance provider.</td>
<td>• Travel, per diem, and salary for a short-term technical assistance provider.</td>
</tr>
<tr>
<td>• GPS devices, GPS software, and GIS software (usually supplied by the technical assistance provider).</td>
<td>• GPS devices, GPS software, and GIS software (usually supplied by the technical assistance provider).</td>
</tr>
</tbody>
</table>

**What information already exists?**

One of the more important initial steps in determining the need and feasibility of a supply chain assessment is undertaking secondary research to determine what relevant data and information already exist. For example, sufficient data for a situational analysis (but not for a more complex longitudinal study) can often be found in surveys already conducted by other organizations or, as noted above, through an LMIS or supervisory system.

Some helpful sources of country-level evaluations are the—

- Demographic and Health Survey (DHS): [www.measuredhs.com](http://www.measuredhs.com)
• International Reproductive Health Surveys (RHS): http://www.cdc.gov/reproductivehealth/surveys/
• Service Provision Assessment (SPA) Survey: www.measuredhs.com/aboutsurveys/spa
• HIV/AIDS Indicator Survey (AIS): www.measuredhs.com/hivdata
• Malaria Indicators Survey (MIS): www.measuredhs.com/aboutsurveys/mis
• Multiple Indicator Cluster Survey (MICS): http://www.childinfo.org/mics
• The Strategic Pathway to Reproductive Health Commodity Security (SPARHCS): http://deliver.jsi.com/dhome

The above-listed surveys are conducted in many countries on a recurring basis and provide useful data for making comparisons. Surveys of this kind also have database and GPS coordinates of health facilities available for download. These data may be used to compare results collected in the LIAT and, through the matching of GPS coordinates, even compare data for individual sites.

Secondary research can also help understand background issues that affect a logistics system, such as product demand and the rate of commodity usage, as well as potential future sources of donations. Familiarity with the country’s health policies, annual budget, standard treatment guidelines, and list of essential medicines will help to clarify constraints on the supply chain system under evaluation. A country’s strategic plan (as it relates to supply chain management) will also help evaluators understand the logistics system before the assessment begins and will help focus the survey on capturing the most important information needs.

A better understanding of the factors affecting the supply chain may lead the evaluation coordinator or country program to adapt the LSAT or LIAT questionnaire to extract more useful information. Adaptations most often involve adjusting questionnaires to refer specifically to product lists and categories, the precise logistics forms that are used, correct administrative zone divisions, and correct titles for program stakeholders and role players.

What are stakeholders’ roles?

Ownership of the assessment process and its results by ministries of health and other program stakeholders is crucial to success, even when a survey is being conducted on behalf of a donor or another outside group. Involving stakeholders from the beginning of assessment planning is the best way to foster client ownership and manage expectations. For example, if a client wishes to conduct an exhaustive assessment at a low cost, it is important to explain what information a survey can capture, particularly in relation to the amount of available financing for the activity. It is especially important to remind stakeholders to collect only data that will be used for decision making to avoid the expense of accumulating information that will ultimately not be useful. Helping a client set realistic expectations through regular involvement in the assessment planning process is a critical step in allowing a survey to start on time and stay on budget.

During the planning stage, it should be determined which organizations will provide assistance, including vehicles, personnel, and financing. Regardless of material or financial input, primary stakeholders should provide personnel, if at all possible. Including stakeholders in the assessment will allow their staff to gain a perspective of the situation on the ground, and will foster a sense of ownership over the information and responsibility to act on the results.

It is suggested that one organization be the main implementer of the assessment to avoid confusion over roles and responsibilities. In most cases, the MOH is the agency that is requesting the assessment; therefore, it plays a key role in its planning and oversight. However, well-coordinated
implementation is vital to the success of an assessment, and the entity that has this responsibility should know exactly what is needed to ensure the appropriate amount of coordination and communication with the government ministry.

Box 1. Chapter Summary: Planning an Assessment

- Supply chain assessments should ideally be conducted at the beginning, mid-term, and end of a program cycle as a way to track the success of interventions and identify issues. The feasibility of conducting assessments at each of these points is influenced by the availability of adequate financial, human, and material resources, and stakeholder agreement.
- Undertaking secondary research to determine what relevant information already exists can help reduce the time and cost of data collection in the field, and can provide some evidence for decision making when conducting an assessment is not practical.
- All relevant stakeholders should develop and approve accurate budget estimates beforehand to better ensure that intended objectives are met. The budget will depend on the size and scope of the assessment.
- Ownership of the assessment process and its results by ministries of health and other program stakeholders is crucial to success, even when a survey is being conducted on behalf of a donor or another outside group.
- Among stakeholders, it is suggested that one organization be the main implementer of the assessment to avoid confusion over roles and responsibilities.
Using the LSAT

The Logistics System Assessment Tool (LSAT) is used to conduct discussion groups and key informant interviews for assessing 11 elements that comprise public and private sector logistics system, and their enabling environments, including:

1. Organization and staffing
2. Logistics management information systems (LMIS)
3. Product selection
4. Forecasting
5. Procurement
6. Inventory control procedures
7. Warehousing and storage
8. Transport and distribution
9. Organizational support
10. Product use
11. Finance, donor coordination, and commodity security planning

These elements are relevant to all logistics systems, whether in the public sector or private sector.

As a diagnostic and monitoring tool, the LSAT can be used to complete annual assessments and contribute to work planning. Information collected using the LSAT is analyzed to identify issues and opportunities and, from those, outline further assessments if additional information is needed, as well as appropriate interventions.

Because assessments using the LSAT are conducted and analyzed in successive years, the results can be used to monitor and improve system performance, and to provide critical data that can identify a country’s commodity security strengths and weaknesses. The LSAT can—

- provide stakeholders with a comprehensive view of all aspects of a logistics system;
- be used as a diagnostic tool to identify logistics and commodity security issues and opportunities;
- raise collective awareness and ownership of system performance and goals for improvement;
- be used by country personnel as a monitoring tool (to learn and continually improve performance); and
- provide input for work planning, particularly when conducted within the three-month period prior to work planning exercises.

Planning

To produce effective results that can be used for decision making, it is essential for an assessment to fit the context of the supply chain it is evaluating, in terms of the specific information being sought with the LSAT, the method of collecting data, and the people who will provide those data.
Preparatory Research

A thorough review of the LSAT questionnaire and research on certain assessment aspects should be conducted before discussions or interviews begin. Examples of documents that will be useful in preparatory research are standard operating procedures (SOPs), guidelines, policies that include logistics, and national drug lists. This information should be presented and validated during the course of the assessment.

Choosing a Data Collection Method

Choosing whether to use the LSAT to facilitate discussion groups, key informant interviews, or both will influence planning. Program managers and country counterparts should be consulted to determine which approach will be used.

Large discussion groups may require sessions that last one to one-and-a-half days to capture the breadth and depth of data required and to provide an adequate opportunity for full participation by all persons involved. If work planning is part of the exercise, it will further extend the time needed for the sessions.

Using the LSAT as a guide for key informant interviews can take up to two weeks or more because of the time required to schedule and conduct multiple interviews with the people who have knowledge about the many components of the logistics system.

Option 1: Discussion Groups

Using the LSAT to facilitate discussion groups can be organized in different ways—

- Joint discussion groups (recommended)
  - Both central-level and lower-level participants can be brought together in one session. This session will probably include 15–25 participants and will require skilled facilitation. This will probably take one to two days to complete, depending on the number of participants and the level of work planning included in the exercise.

- Separate central-level and lower-level discussion groups
  - Central-level group sessions should include approximately 10–25 participants and are the minimum requirement for using discussion groups for information collection.
  - Lower-level group sessions generally comprise a cross-section of units (e.g., districts), although it may be necessary to select a different subset, such as a particular geographic area or units under a particular set of circumstances. This option will require at least one day at each site.

Option 2: Key Informant Interviews

Using the LSAT as an interview guide to collect information from numerous key informants can take one week or more, mainly due to the time it takes to schedule and conduct all interviews (usually at separate locations), ensure that the range of information sought is provided across the pool of interviewees, and consolidate data for a harmonious final report.

One disadvantage to this approach is that it does not allow for group discussion between people working in different areas of the supply chain, which promotes an exchange of ideas and information, as well as consensus building around answers. If this approach is used, it is recommended that a stakeholders’ meeting be held to present and discuss the assessment findings.
Option 3: Discussion groups and key informant interviews

A combination of data collection methods is often quite useful when using the LSAT. When group discussions do not involve all of the intended participants, or information gathered this way is not complete, key informant interviews can provide invaluable supplementary data. Key informant interviews can also be used as a first step before group discussions, providing organizers with an opportunity to adapt the LSAT in advance in collaboration with experts on the local supply chain context.

Selecting Participants

To collect thorough and accurate data about each aspect of the logistics system, it is important to select the appropriate set of people to participate.

For year-to-year use of the discussion group option, it is useful to work consistently with the same core group of participants as a way to build internal capability for conducting supply chain assessments and to improve the reliability of the data. It is best to consider already-existing groups, such as logistics committees, as a source of participants.

Each participant should be knowledgeable about one or more of the 11 areas covered by the LSAT and, ideally, have hands-on experience with the logistics system at the level the participant is representing (i.e., central or lower level).

Program managers should identify appropriate participants. It is advisable to consider international donors and Ministry of Finance personnel for the finance knowledge area. It is also useful to include someone with policy expertise because policy questions are incorporated into several sections. Central-level discussion groups or interviews should include participants with a knowledge base in all LSAT areas, but knowledge of organization and staffing, product selection, forecasting, and procurement (i.e., central-level functions) may be excluded at lower levels of the system if these functions are highly centralized.

Field Visits

It is recommended that facilitators or interviewers make a limited number of field visits. Field visits made prior to the discussion sessions and interviews will provide a sample of the current context or circumstances, which will add additional insight into the information collection.

Visits made following the discussions/interviews offer an opportunity to further explore issues that were identified, enhance the quality of the information gathered, and allow for additional data collection. Individuals making the field visits can focus on unanswered LSAT questions; data that are mixed, unclear, or that have been disputed; and disparate or wide-ranging responses to questions. Program managers or country counterparts can help plan the appropriate number of field visits before and/or after the exercise.
Data Collection

The methods for collecting data through discussion groups and key informant interviews are fairly similar, but activities for each are planned and organized differently. A flowchart for determining a data collection method for system assessments using the LSAT is available in Appendix B.

Option 1: Discussion Groups

As noted earlier, information-gathering sessions should be led by a skilled facilitator who is familiar with the LSAT. Field experience has also shown that having multiple recorders who are also familiar with the tool is more likely to result in capturing high-quality information.

Facilitators should set the tone for the session by explaining how the participants’ input will be used and what they want to hear from each person about their area of knowledge, as well as how they see the technical areas relating to and impacting one another.

In the sample agenda shown in Box 2, Organization and Staffing is covered through discussion with the entire group (plenary), followed by group work for the remaining sections.

### Box 2. Suggested Discussion Session Timing

<table>
<thead>
<tr>
<th>Time</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>8:30–9:00 AM</td>
<td>Introduction, Objectives, and Agenda (plenary)</td>
</tr>
<tr>
<td>9:00–10:00</td>
<td>Organization and Staffing (plenary)</td>
</tr>
<tr>
<td>10:00–10:15</td>
<td>Break</td>
</tr>
<tr>
<td>10:15–1:00</td>
<td>Group Work by LSAT Component</td>
</tr>
<tr>
<td>1:00–2:00</td>
<td>Lunch</td>
</tr>
<tr>
<td>2:00–2:30</td>
<td>Group Work Presentation Preparation</td>
</tr>
<tr>
<td>2:30–4:30</td>
<td>Presentations on Section Strengths, Weaknesses, and Recommendations and Discussion</td>
</tr>
<tr>
<td>4:30–5:00</td>
<td>Synthesis and Closure*</td>
</tr>
</tbody>
</table>

*A half-day closing should be considered if the goal of the session is not only to synthesize previous sessions, but also to prioritize and plan interventions.*
Suggested section pairings and guidelines for group work are provided in Box 3. Some questions in each section can be satisfactorily completed prior to the session, reducing the time needed to complete the remaining questions. However, if this is not possible, follow-up discussions about specific questions will likely be necessary.

Box 3. Suggested Pairings and Guidelines for Group Work

It is effective to establish six work groups based on the LSAT components—

- Group I: Logistic Management Information System (LMIS)
- Group II: Forecasting, Procurement, Product Selection
- Group III: Inventory Control, Product Use
- Group IV: Warehousing and Storage, Transportation, and Distribution
- Group V: Organizational Support
- Group VI: Finance, Donor Coordination, and Commodity Security

Each group should—

1. Choose a group facilitator and presenter.
2. Complete the relevant questionnaire sections for the components assigned to your group.
3. Identify relevant issues to be discussed with the group for validation, if any.
4. Determine at least three strengths and three weaknesses.
5. Provide associated recommendations for each section (see below).
6. Write group work results on a flip chart or create a PowerPoint presentation.
7. Present the group work.

Groups should base the recommendations they make on SMART-I parameters, meaning they are:

- S = Specific/Strategic
- M = Measurable
- A = Attainable
- R = Realistic
- T = Time-bound
- I = Implementable

Option 2: Key Informant Interviews

Set up interviews with key informants and experts to cover each of the LSAT components. During the interviews, review the relevant sections with them and record their responses, asking for supporting documentation when needed. If respondents are unable to answer a question, ask them where the information you are looking for might be found.

Present the information collected through key informant interviews in a meeting with stakeholders; you can discuss findings and their implications. The facilitator or interviewer will also need to compile the results in a report. The collected information should identify the key strengths and weaknesses of the system. Using the criteria described in the analysis section below to identify objectives, it should also lead to the development of recommendations and a work plan.
Option 3: Discussion Groups and Key Informant Interviews

The above-described data collection principles for group discussions and key informant interviews should be employed in tandem when combining both methods in the same assessment.

Scoring

The scoring sheet is an effective mechanism for synthesizing data into a manageable number of questions and, taken together, paint an overall picture of the logistics system. The scoring sheet contains core questions for all 11 sections of the LSAT; instructions on scoring; and summary boxes for strengths, weaknesses, and general recommendations. The scoring sheet can be found in the LSAT document that is part of the toolkit.

Data Analysis

The information collected using the LSAT can be used to inform the work planning process and can be used to monitor progress over time.

Work Planning

To inform work planning, users can review the strengths and weaknesses of a logistics system and use the information to develop appropriate objectives and interventions as part of an effective work plan.

If time allows, a participatory analysis of the LSAT discussion results is highly recommended. This is especially recommended when group discussions are used for data collection because the participants are already together. Such a session can take up to one day and includes—

- Developing a consolidated summary of the key points and observations (e.g., strengths and weaknesses).
- If an LSAT has previously been done, comparing the current and prior year’s findings and noting reasons for any significant changes, including assumptions that did not work.
- Identifying key existing conditions or circumstances (i.e., the context) that will influence the choice of objectives and interventions.
- Identifying objectives or reevaluating objectives from the previous year.
- Using the Objectives and Interventions Worksheet (available in the LSAT document) to define and prioritize follow-up actions.

Monitoring

Commodity security is increasingly a global concern. At the same time as resource availability is decreasing, people’s awareness of and desire to use certain commodities is increasing. Supply often fails to meet demand in these circumstances. Proper management of health products when they are received, and ensuring that they reach the end users for whom they are intended are key elements in meeting the challenge of commodity security.

Ideally, to monitor changes in the logistics system over time, the LSAT should be carried out at regular intervals, preferably once a year. Scores from one year to the next can then be compared to track progress and adjust interventions as needed.
Box 4. Chapter Summary: Using the LSAT

- The Logistics System Assessment Tool (LSAT) is used to assess 11 elements that comprise public and private sector logistics systems, and their enabling environments: organization and staffing; logistics management information systems; product selection; forecasting; procurement; inventory control procedures; warehousing and storage; transport and distribution; organizational support; product use; and finance, donor coordination, and commodity security planning.

- Data collection with the LSAT can be conducted through discussion groups, key informant interviews, or a combination of the two. Background research and field visits are key additional activities that help assessment teams adapt the LSAT to better fit the context of the system being evaluated and to obtain information that could not be gained through discussions or interviews.

- It is highly recommended that analysis of the LSAT discussion results be conducted with participants, including developing a consolidated summary of key points and observations; comparing results to any previous assessments; identifying existing circumstances that will influence the choice of objectives and interventions; and identifying and prioritizing objectives.

- To monitor changes in the logistics system over time, the LSAT should ideally be carried out at regular intervals, preferably once a year.
Using the LIAT

The Logistics Indicators Assessment Tool (LIAT) is a quantitative data collection instrument that is used to conduct surveys that assess health commodity logistics system performance and commodity availability at health facilities. The LIAT can be used to monitor the performance of certain processes involved in the logistics management of health commodities over time, to evaluate certain outcomes of logistics interventions, to provide ongoing supervision and performance monitoring, and to monitor commodity availability.

The data collected using the LIAT can be used to calculate the following core logistics indicators:

- Accuracy of logistics data for inventory management.
- Percentage of facilities that receive the quantity of products ordered.
- Percentage of facilities that maintain acceptable storage conditions.
- Percentage of facilities whose stock levels ensure near-term product availability (stock status).
- Percentage of facilities that experienced a stockout at any point during a given period or at the time of the visit.

In addition to these indicators, the data collected can be used to calculate additional related indicators, such as frequency of stockouts over a given period, duration of stockouts, and more.

Supplemental questions provide additional information about the characteristics of the supply chain being assessed, such as the use of LMIS information, ordering procedures, transport systems, supervision frequency, cold chain management, and others.

Survey Design

Experimental and non-experimental survey designs may be used in evaluations conducted with the LIAT. Selecting a survey design depends greatly on what is being measured and the availability of resources for implementation.

Experimental Design

Surveys that employ experimental design produce the most reliable results. Experimental design comprises data collection from a randomly selected control group and a randomly selected intervention group. This helps establish a fairly clear picture of a program’s impact by comparing the difference between areas where specific interventions have been implemented and areas where they have not. Although experimental design is considered to be the most sound assessment method, it is also the most costly because it requires collection from a large number of sites.

In the particular case of supply chain assessments, experimental design may not be feasible because it is often impossible to identify a control group. That is, because supply chains generally cover entire countries, a control group within a country (i.e., an area not served by the supply chain) usually doesn’t exist. With this in mind, experimental design could be very effective for evaluation of a pilot project occurring in a limited intervention zone or to analyze a situation in which different logistics processes are being used in different areas of a country. However, ethical issues of
providing an intervention to one group and not to the control group should be weighed before considering an experimental design.

**Non-Experimental Design**

Non-experimental designs, which do not include a control group, are widely used by programs that do not have sufficient resources to fund data collection from both an intervention group and a control group. Inasmuch as non-experimental designs lack a control against which to measure changes, they are less reliable than experimental designs. Yet, well-conducted surveys using non-experimental design can still produce valuable, accurate data for decision making in supply chain management, particularly when complementary qualitative information is gathered using the LSAT to determine what factors may have influenced outcomes.

Because non-experimental design does not include data collection from a control group, it is important to collect information at the beginning of a program cycle so that comparisons can be made to data collected at later points, especially the end of the program cycle. That being said, collecting data only at cycle end is extremely common in supply chain programs in the developing world, mainly due to limits in funding availability. End-point-only assessments can be useful for understanding the situation on the ground at a particular point, but are not effective in measuring change, particularly when a systems assessment is not undertaken (with the LSAT) at the same time.

Programs lacking adequate funding to conduct a baseline survey may choose to carry out initial data collection at a later point when funding becomes available. A program will need to assess whether there is enough time left in its lifecycle to permit the intervention to exhibit meaningful change; since there are many external factors determining the success of a particular intervention, it is up to the program to decide whether enough time has passed to allow the intervention to take hold.

**Selecting a Survey Design**

Table 1 summarizes the relative strengths and weakness of the survey design types detailed above.

| Table 1. Strengths and Weaknesses of Commonly Used Facility Survey Designs |
|-----------------------------|---|---|
| **Design** | **Advantages** | **Disadvantages** |
| Experimental Design | • Strongest design | • Requires that control and intervention groups be similar to one another at start of intervention. |
| | • Provides a good estimate of a program’s impact. | • Control group must not be influenced by intervention for length of program cycle. |
| | • Data is highly reliable. | • Cost and time resources can be high. |
| Non-Experimental Designs | • Provides an approximate estimate of a program’s impact. | • Results are not as rigorous as those in experimental design surveys. |
| | • Costs are lower than experimental design approaches because the sample size is usually smaller. | |
In cases where a pretest assessment is not conducted, a post-test could still be useful for exploratory studies. However (as noted in Table 1), no comparisons can be drawn or impact determined in this case. In addition to the information provided above, a flowchart for determining survey design type for facility-level assessments using the LIAT can be found in Appendix 3.

## Sampling

After selecting a survey design, the sample from which to collect data must be determined. This comprises identifying the number of facilities needed to produce sufficient information on supply chain efficiency, randomly selecting specific facilities in a manner that produces the right mix of facility types, and developing a strategy to organize collected data.

### Geographic Coverage

It is important to consider the areas of a country that a survey will cover. A large, well-funded survey may include all main regions or states of interest. But a smaller data collection area may be necessary due to limited resources or other programmatic reasons, such as avoiding locations that are not within a program’s reach (e.g., mountainous regions would not be included in a malaria initiative). In addition, accessibility to specific regions may be affected by seasonal variables, such as a heavy rain or political conflict due to approaching elections. Faced with obstacles of this sort, stakeholders will have to decide whether to postpone or scale back an assessment.

Whatever the makeup of a geographic area being studied, these decisions will have to be discussed ahead of time with stakeholders during the process of obtaining the personnel and financial resources that are needed for an assessment. The decision to scale back the scope of an assessment must be balanced against the need for sufficient data. An assessment scope that is too limited runs the risk of producing results that may not be representative of the true situation on the ground.

### Facility Types

Depending on the supply chain being assessed, a survey may need to include public, private, commercial, and NGO health facilities. The consideration of which types of facilities to include may also depend on the interest of the stakeholders involved and the feasibility of evaluating the different sectors.

It is also particularly important to determine the types of participating facilities before developing the sample size and selecting sites. In the majority of health facility assessments, the lowest level of the supply chain (i.e., the service delivery point) is of most interest to programs.

### Developing a Sampling Frame

Determining geographic coverage and facility types is essential to developing a sampling frame from which to determine the sample size and the specific facilities to visit. A sampling frame is simply a
finalized list of facilities that meet the specific criteria of the assessment. Sampling frames should only include those facilities that will be useful in evaluating the supply chain system.

The first step in developing a sampling frame is to obtain an updated and complete list of health facilities that are being supplied by the logistics system under evaluation. The list can be exhaustive and include all health facilities covered by the logistics system, or it can be streamlined to include only particular geographic areas. Apart from inclusion in a control group (if an experimental design is being employed), any facilities in geographic areas that are not selected for evaluation due to political, programmatic, or accessibility reasons should also be removed.

The next step is to remove from the sampling frame facilities whose administrative characteristics do not fit the purpose of the assessment. Most health facility assessments will look at the various levels of a health system, including primary, secondary, and tertiary health facilities. Several types of health facilities categorized as primary health facilities may not fit the criteria of the assessment due to special characteristics that are not consistent with those of most other facilities. For example, certain health posts may not receive supplies directly from a higher-level facility or may not be required to keep stock records because the number of clients they receive is so high that all available staff time must be devoted to providing services. In such instances, it is practical to remove all such health posts from the facility list since the data from these facilities may not be useful in analyzing the supply chain. In fact, all facilities should be judged in this way to include only those that meet the criteria of the assessment.

The final step in developing a sampling frame is to remove all facilities that are known to be closed (permanently or seasonally) or otherwise inaccessible to the data collection teams.

Whether removing facilities because they do not fit the criteria of the assessment or they are non-functional, decreasing the sampling frame must be done in a purposeful manner to avoid the appearance of bias. It is not legitimate to remove health facilities that are remote or are perceived to be unimportant because such facilities often experience the greatest logistics challenges, and excluding them from the sample can give an inaccurate picture of how well a logistic system is functioning. Every viable health facility should have an equal chance of being selected for the assessment and, therefore, should be included in the sampling frame.

### Calculating Sample Size

Ideally, an evaluation team would gather information from the entire group or population of health facilities being targeted in an assessment. But, since this would exhaust available resources in most settings, a subset or sample that allows a fairly accurate representation of all facilities can be assessed instead. For example, a population might include all health facilities in a country’s tropical subregion that provide antimalarial medicines, and a representative sample of that population would consist of five service delivery points at each level of the health system.

While visits should be made to as many facilities as possible at all levels of the system, it is not mandatory in all cases to select a statistically significant sample when using the LIAT. This is particularly true for initial program cycle assessments aimed at identifying systemic issues; coupled with information gathered from a LSAT, a non-statistical sample would likely yield valuable information for program managers. However, when establishing baseline data for a program cycle, it is important to have a ample number of facility visits to measure change. Seeking a statistically significant sample is highly encouraged when programs will be called upon to show results at the end of the program cycle or if a nationally representative sample of the health facilities is desired. As demonstrated in the following section, ensuring a sample of high statistical significance can often
involve a high number of site visits, although there are steps to take to make a representative sample more attainable.

**Acquiring Sample Sizes of Statistical Significance**

To better ensure that the results of any assessment can be considered representative and true (not due simply to chance), evaluators should collect data from a random and sufficiently large sample. Sample size should be determined based on indicators that are of most importance to the program (e.g., in the case of a LIAT, availability of a particular product on the day of visit). It is critical to ensure that a sufficient number of facilities where the particular product is supposed to be stocked are sampled to accurately measure change in the key indicators and confidently present data to decision makers. It is therefore essential to properly define the study population when developing the sampling frame.

The three primary factors that are used to determine the sample size for simple random samples are the estimated prevalence of your disease or outcome of interest (i.e., percent of facilities that experienced a stockout at any point during a given period), the margin of error, and confidence level that evaluators determine to be acceptable. The margin of error measures the precision with which an estimate from a single sample approximates the population. The confidence level is the probability that a population estimate lies within a given margin of error. Take the example of an assessment team that sets a 6 percent margin of error (+/-3 percent) and a 95 percent confidence level. If 77 percent of facilities surveyed in their assessment were shown to be correctly using stock cards, one could conclude there is a 95 percent likelihood that 74 to 80 percent of all facilities are correctly using stock cards.

In many situations, the margin of error and confidence level may be relaxed to allow for an attainable sample size. A more realistic margin of error and confidence level for a LIAT survey might be 20 percent (+/-10 percent) and 90 percent, respectively. For generating representative samples for a LIAT survey, it is recommended that evaluators set a margin of error at or below 20 percent and a confidence level at or above 90 percent. (Note: For preserving statistical significance, it is more important to maintain a higher confidence level than it is to maintain a smaller margin of error.) Whatever the margin of error and confidence level selected, be sure to clearly state the parameters used to calculate sample size when presenting LIAT survey results to stakeholders.

The general formula for calculating a sample size is:

\[ n = \frac{t^2 \cdot p(1-p)}{m^2} \]

where:

- \( n \) = required sample size
- \( t \) = the value of the confidence level you have chosen (at 80 percent \( t = 1.28 \), 90 percent = 1.64, 95 percent \( t = 1.96 \))
- \( p \) = estimated prevalence of the indicator. (The product of \( p \) and \( 1-p \) is maximized when \( p = 0.5 \). Therefore, when prevalence is unknown, 0.5 should be used.)
- \( m \) = margin of error you wish to allow in estimating the prevalence, expressed as a decimal (at 20 percent \( m = 0.2 \), at 10 percent \( m = 0.1 \), at 5 percent \( m = 0.05 \)).
However, where there is a predetermined population (e.g., total number of facilities in the country), the sample size generated from the above equation needs to be multiplied by the Finite Population Correction (FPC) factor. For our purposes, the formula can be expressed as:

\[
\text{New n} = \frac{n}{1+[(n-1)/N]}
\]

Where:

- New n = the adjusted new sample size
- N = the population size
- n = the sample size obtained from the general formula

Using the example above, ensuring a 6 percent margin of error and a 95 percent confidence level would require:

- Visits to 175 facilities in a population of 500 facilities
- Visits to 211 facilities in a population of 1,000 facilities

However, by expanding the margin of error to 10 percent and a confidence level of 90 percent, it would require:

- Visits to 60 facilities in a population of 500 facilities
- Visits to 64 facilities in a population of 1,000 facilities

Note that the sample size does not vary considerably between population sizes. The main difference exists between margin of error and confidence levels.

The sample size equations given above are for simple random sampling or, in other words, when it is possible to select the respondent (e.g., health facility) from the entire population (e.g., a country). However, due to travel or resource constraints (e.g., logistics, funding), it might be necessary to use cluster sampling to obtain results, where the total population is divided into smaller groups (or clusters) and a sample of the groups is selected. For example, using the study sampling frame developed earlier, the surveyors would begin by randomly selecting at a high level, such as sampling from regions or districts. Then they would randomly select clusters from within those districts/regions, and then within those randomly sample facilities. In these situations, in order to produce survey estimates with the same precision as in a simple random sample, the sample size should be multiplied by the design effect (DEFF).

The DEFF can be interpreted as the factor by which the sample size for a cluster sample would have to be increased to produce survey estimates with the same precision as a simple random sample. It reflects the effects of stratification, stages of selection, and degree of clustering used in the facility survey. The magnitude of the DEFF depends on the intraclass correlation coefficient or ICC (i.e., the degree of similarity within the cluster on the variable of interest) and the average cluster size. Ideally, an estimate of DEFF for the indicators can be obtained from prior surveys in any setting.
However, when no information is available, the default value of DEFF = 1.2 is recommended with facility-based assessment.¹

Thus, the sample size from the above equations is multiplied by the DEFF (1.2) and then divided by the number of clusters to be sampled to determine the number of observations needed per sampled cluster (or district):

\[
\text{n per cluster sampled} = \frac{(\text{New n} \times \text{DEFF})}{\text{Number of clusters sampled}}
\]

It should be noted, that in most LIAT surveys one does not need to account for the DEFF, since simple random sampling or probability proportionate to size sampling, rather than cluster sampling, is being used in the sample frame. However, as mentioned earlier, it is very important to base the study sample size on the lowest level of interest. For instance, using the formulas above, one is only obtaining a sample large enough to test for significance at the largest sample level (i.e., national level). If one wants to measure results at the lower levels (i.e., regional or district level), one would need to calculate the sample size at these levels and adjust the total sample size upward accordingly for national representation.

To summarize, assessment teams should aim to strike a balance between a realistically feasible number of site visits (given time and resource constraints) and the amount of data that is needed to develop evidence-based, compelling recommendations for improvements to the supply chain. Always consult a statistician before determining the number of facilities to target in a given population.

**Box 5. Examples of Acquiring Sample Sizes of Statistical Significance**

**Example 1:**

You are conducting a LIAT survey and have agreed with stakeholders that your survey size will have a 90 percent confidence level and a 6 percent margin of error. While there are 1,800 facilities in 85 districts throughout the 13 provinces in the country, it is only feasible to go to 35 districts where there are a total of 760 facilities.

**Step 1: Calculating general sample size**

\[
N = \frac{1.64^2 \times 0.5(1-0.5)}{0.06^2} \quad n = 187
\]

**Step 2: Accounting for the FPC**

\[
\text{New n} = \frac{187}{1 + ((187-1)/900)} \quad \text{New n} = 150
\]

**Stop here if using simple random sampling**

**Step 3: Multiplying by the DEFF and dividing by clusters**

\[
(150 \times 1.2)/35 \approx 5–6 \text{ facilities per district (for a total of 180 facilities)}
\]

¹ This value is based on recommendations from the Measure Evaluation “Sampling Manual for Facility Surveys for Population, Maternal Health, Child Health and STD Programs in Developing Countries” (http://www.cpc.unc.edu/measure/publications/pdf/ms-01-03.pdf). For household- or population-based surveys, the DEFF value generally varies between 1.5 and 2.0.
Example 2:
You are conducting a LIAT survey and have agreed with stakeholders that your survey size will have an 80 percent confidence level and a 5 percent margin of error. While there are 800 facilities in the country in 10 districts, it is only feasible to go to 40 districts where there are a total of 200 facilities.

Step 1: Calculating general sample size
\[ N = \frac{1.28^2 \times 0.5(1-0.5)}{0.05^2} \quad n = 163 \]

Step 2: Accounting for the FPC:
\[ \text{New } n = \frac{163}{1 + \left(\frac{(163-1)}{200}\right)} \quad \text{New } n = 90 \]

Stop here if using simple random sampling

Step 3: Multiplying by the DEFF and dividing by clusters
\[ \frac{(90 \times 1.2)}{40} = 2 - 3 \text{ facilities per district (for a total of 108 facilities)} \]

Deciding upon a Sampling Methodology
There are two types of sampling methodologies: probability sampling and non-probability sampling. Probability sampling involves randomly selecting members of a population to create a sample, thereby reducing the risk of bias because each member of the population has a non-zero chance of being included in the sample. Non-probability sampling relies on the judgment of the assessment coordinator to select the study participants. Probability sampling should be employed in assessments that use the LIAT, while non-probability sampling is more appropriate for qualitative evaluations, including those conducted with the LSAT.

Types of Probability Sampling
Below are four commonly used types of probability sampling: simple random sampling, stratified random sampling, systematic sampling, and cluster sampling. A flowchart for determining sampling method for facility-level assessments using the LIAT is provided in Appendix 4.

Simple Random Sampling
Simple random sampling begins with the creation of a sampling frame that includes all eligible facilities. Facilities in the sampling frame may be identified by name or by an assigned number. Then, using a random number generator (see “Steps in Sampling” below), facilities are selected one by one until the number of selected facilities equals the size that was determined for the sample. It is important that sampling be done with replacement. That is, all of the facilities (even those already selected) should be included in the sampling frame each time a new random selection is made. This allows all facilities to have an equal chance of being selected and simply requires that, when a facility is selected more than once, it should be skipped, and the random selection process should continue until the desired number of different facilities is reached.

Simple random sampling is easy to use and is considered to be an unbiased selection process. However, simple random sampling does not allow for sampling of different subgroups (strata) within a population. For example, hospitals and primary health facilities would have an equal chance
of selection in simple random sampling, so the resulting sample could have an extremely high number of one type of facility and very few of the other.

**Stratified Random Sampling**

Stratified random sampling has the same characteristics as simple random sampling, but it allows for the analysis of different strata within a population. Simple random sampling is carried out for each subgroup instead of only for the population as a whole. For example, separate samples of warehouses, hospitals, and primary health facilities would be established. In this case, a sample size of each stratum would need to be calculated.

The benefit of stratified random sampling is its ability to facilitate meaningful comparisons between strata. Strata can be defined as the different levels of a supply chain, different facility types, or different ownership of the facilities (i.e., public versus private). A challenge exists in appropriately defining the different strata needed for the desired comparisons. The central issue with stratified random sampling is that the cost and complexity of the assessment tend to increase each time a new stratum is defined.

**Systematic Sampling (Proportional-to-Size Sampling)**

Systematic sampling is a third sampling technique that can be used to select facilities for an assessment. This sampling technique uses a sampling interval to randomly select facilities from the sampling frame. The sampling interval is calculated by dividing the total number of facilities in the sampling frame by the number of facilities determined for the sample size. For example, a sampling frame of 1,000 and a sample size of 100 would yield a sample interval of 10. With this figure, a starting point is selected at random using a number between 1 and 10, and then every 10th facility following the random number starting point would be selected until the number of facilities selected equals the sample size.

Systematic sampling is easy to use, especially when dealing with a large number of facilities in a complete sampling frame. The disadvantage of using this method is that bias could be introduced if the list of facilities is patterned in such a way that it promotes the selection of a certain type of facility. For example, the list is organized by facility type so that every 10th facility is more likely to be a hospital than it is to be a service delivery point.

**Cluster Sampling**

A cluster is a naturally occurring subgroup, such as health facilities under an administrative area (e.g., region, district). In cluster sampling, all or a selection of health facilities are chosen from a select number of subgroups. Cluster sampling uses a multi-stage approach where subgroups are selected from the various levels of a supply chain and, finally, from health facilities within the cluster. This sampling approach is particularly useful for assessments with limited resources; fewer geographic areas need to be visited, which helps to reduce overall costs. However, considerations with regard to sample size must be addressed, particularly, the “design effect” where the number of facilities is multiplied to account for differences between clusters.

A main difference between stratified random sampling and cluster sampling is that stratified random sampling involves selecting facilities from the whole population of the strata, whereas with cluster sampling, selection occurs only within a limited number of selected clusters.
Comparing Probability Sampling Methods

Table 2 summarizes commonly used probability sampling types, including the four types described above for surveys that employ the LIAT.

### Table 2. Commonly Used Probability Sampling Types

<table>
<thead>
<tr>
<th>Sampling Type</th>
<th>Description</th>
<th>Benefits</th>
<th>Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple Random Sampling</td>
<td>Each unit has an equal chance of selection.</td>
<td>Unbiased; relatively easy to use.</td>
<td>Groups of interest may not be selected in proper proportion.</td>
</tr>
<tr>
<td>Stratified Random Sampling</td>
<td>Population is divided into meaningful groups or strata.</td>
<td>Enables analysis of subgroups.</td>
<td>Sample size must be calculated for each stratum; can be costly if using many strata.</td>
</tr>
<tr>
<td>Systematic Sampling (Proportional-to-Size Sampling)</td>
<td>Every Nth unit on a list is selected based on dividing the size of the population by the sample size.</td>
<td>Convenient if facility list is provided; as good as random sampling if starting point is obtained randomly.</td>
<td>Attention must be paid to recurring patterns within the sampling frame.</td>
</tr>
<tr>
<td>Cluster Sampling</td>
<td>Sampling is conducted from naturally occurring subgroups.</td>
<td>Sampling from subgroups may allow for savings in time and logistics.</td>
<td>Design effect may necessitate an increase in sample size.</td>
</tr>
</tbody>
</table>

Using Purposeful Sampling for LIAT

Because most health commodity logistics systems enable health products to reach service delivery points via a system of warehouses or depots, it is important to assess these storage points. Some LIAT indicators are designed to enable evaluation of the linkage between service levels, including region-to-district and district-to-service delivery point. Thus, a survey often needs to employ a certain amount of “purposeful sampling” to guarantee that the facilities selected for the sample are truly linked to each other. Alternatively, random sampling can be done at a higher level (regional level) and, then further sampling can be done at the district level before sampling the health facilities within that district. Attention will have to be paid to whether the selected districts have an adequate number of health facilities to properly reach the required sample size of health facilities.

Steps in Sampling

Once a sampling frame and sample size have been generated, a representative sample of health facilities can be drawn using the sampling methodologies mentioned above. As long as a sample is ultimately determined without bias, any type of random number generator can be used, including rolling dice, drawing numbers from a hat, using a random number table, or using a website designed to generate random numbers (e.g., http://www.random.org).

Example: Generating a Sample Using Simple Random Sampling

The Ministry of Health in Sangala wanted to conduct an assessment of its malaria supply chain, but it did not have the resources to visit every service delivery point that offers antimalarial medicines. In consulting with a statistician from the country’s National Statistical Service, the Ministry decided that the most efficient way to conduct its assessment would be to generate a random sample that is representative of all facilities offering antimalarials.
The Ministry then:

1. Established a complete list of health facilities providing antimalarials, including verifying the geographical coordinates that were collected for each during an earlier assessment.
2. Excluded all facilities that did not fit the scope of the assessment, including privately operated clinics and facilities known to be closed.
3. Numbered the health facilities from 1 to 20, shown in the sample list below. (In a real-life situation, sampling would not usually be conducted on a sampling frame of only 20 facilities; instead, all of the facilities would be visited. Sampling should be considered when the total number of facilities in a sampling frame is too great to visit.)

**Sangala—Sampling Frame for Antimalarial Medicine Supply Chain**

<table>
<thead>
<tr>
<th>Province</th>
<th>District</th>
<th>Facility Name</th>
<th>Order Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Southern</td>
<td>Balaka</td>
<td>Kipiri Heath Center</td>
<td>1</td>
</tr>
<tr>
<td>Southern</td>
<td>Balaka</td>
<td>Balaka Health Center</td>
<td>2</td>
</tr>
<tr>
<td>Southern</td>
<td>Balaka</td>
<td>Chilipa Health Center</td>
<td>3</td>
</tr>
<tr>
<td>Southern</td>
<td>Balaka</td>
<td>Chyendu Health Center</td>
<td>4</td>
</tr>
<tr>
<td>Southern</td>
<td>Balaka</td>
<td>Confort Health Center</td>
<td>5</td>
</tr>
<tr>
<td>Northern</td>
<td>Chitipa</td>
<td>Chambo Health Center</td>
<td>6</td>
</tr>
<tr>
<td>Northern</td>
<td>Chitipa</td>
<td>Ifumbo Health Center</td>
<td>7</td>
</tr>
<tr>
<td>Northern</td>
<td>Chitipa</td>
<td>Kameme Health Center</td>
<td>8</td>
</tr>
<tr>
<td>Northern</td>
<td>Chitipa</td>
<td>Kapenda Health Center</td>
<td>9</td>
</tr>
<tr>
<td>Northern</td>
<td>Chitipa</td>
<td>Kaseye Health Center</td>
<td>10</td>
</tr>
<tr>
<td>Eastern</td>
<td>Dedza</td>
<td>Bembeke Health Center</td>
<td>11</td>
</tr>
<tr>
<td>Eastern</td>
<td>Dedza</td>
<td>Chikuse Health Center</td>
<td>12</td>
</tr>
<tr>
<td>Eastern</td>
<td>Dedza</td>
<td>Chimoto Health Center</td>
<td>13</td>
</tr>
<tr>
<td>Eastern</td>
<td>Dedza</td>
<td>Chipwanya Health Center</td>
<td>14</td>
</tr>
<tr>
<td>Eastern</td>
<td>Dedza</td>
<td>Chitowo Health Center</td>
<td>15</td>
</tr>
<tr>
<td>Western</td>
<td>Dowa</td>
<td>Bowe Health Center</td>
<td>16</td>
</tr>
<tr>
<td>Western</td>
<td>Dowa</td>
<td>Chakhaza Health Center</td>
<td>17</td>
</tr>
<tr>
<td>Western</td>
<td>Dowa</td>
<td>Chankhungu Health Center</td>
<td>18</td>
</tr>
<tr>
<td>Western</td>
<td>Dowa</td>
<td>Chinkhwiri Health Center</td>
<td>19</td>
</tr>
<tr>
<td>Western</td>
<td>Dowa</td>
<td>Chisepo Health Center</td>
<td>20</td>
</tr>
</tbody>
</table>

4. Used a random number generator to select five service delivery points, which was the sample size that had been calculated for this assessment. The Ministry was careful to include all 20 numbers each time a site was to be selected using the random number generator and, on two occasions, numbers that had already been selected were redrawn and had to be skipped. The resulting facilities to be visited were those corresponding to numbers 3, 6, 11, 14, and 18.

5. Followed up the sample selection by ensuring that the facilities identified for visits were still operational and would be accessible to the data collection teams.

6. Randomly selected two additional facilities (i.e., 10 percent of the total list) to act as replacements if facilities in the sample were not accessible. The Ministry was careful to select
these replacement facilities ahead of time to reduce the appearance of bias in the sampling process and to ensure that replacement facilities met the criteria of the assessment.

**Establishing a Unique Identifier**

When the sampling process is complete and the number of health facilities selected is equal to the sample size that was set, a list of the selected facilities can be developed.

The key to making this list an essential tool for data organization is assigning a unique identifier for each facility. The unique identifier is typically a numbering scheme that follows a logical progression and makes every facility distinctive. For field work, this unique identifier is important because it allows data collectors to track various forms related to a particular facility. Each form and page of the survey instrument should be marked with the facility’s unique identifier, thus facilitating the submission of completed surveys at the end of data collection, as well as data entry and management. Unique identifiers (as opposed to facility names or geographic coordinates) also provide facilities with a relative amount of anonymity during the data analysis phase.

Although a unique identifier can be any alpha-numeric sequence, a particular numbering scheme is recommended for assessments using the LIAT. The main reason to use the recommended numbering scheme is that it matches the database protocols that were developed to accompany the LIAT and this document. The unique identifier should be made up of three sequences of a three-digit number: ####.####.####. The first three numbers correspond to the code given to the state/region being assessed, the next three numbers correspond to the code given to the district or local government area, and the last three numbers are the code for the facility. Table 3 shows an example of how this numbering scheme for the unique identifier might work.

<table>
<thead>
<tr>
<th>Region Name</th>
<th>Region Code</th>
<th>District Name</th>
<th>District Code</th>
<th>Facility Name</th>
<th>Facility Code</th>
<th>Unique Identifier</th>
</tr>
</thead>
<tbody>
<tr>
<td>Luapula</td>
<td>111</td>
<td>Manza</td>
<td>111</td>
<td>Manza HC</td>
<td>001</td>
<td>111111001</td>
</tr>
<tr>
<td>Luapula</td>
<td>111</td>
<td>Manza</td>
<td>111</td>
<td>Manza Hospital</td>
<td>002</td>
<td>111111002</td>
</tr>
<tr>
<td>Luapula</td>
<td>111</td>
<td>Mweru</td>
<td>222</td>
<td>Mweru HC</td>
<td>003</td>
<td>111222003</td>
</tr>
<tr>
<td>Eastern</td>
<td>222</td>
<td>Chipata</td>
<td>333</td>
<td>Chipata HC</td>
<td>004</td>
<td>222333004</td>
</tr>
<tr>
<td>Eastern</td>
<td>222</td>
<td>Kazembe</td>
<td>444</td>
<td>Kazembe Hospital</td>
<td>005</td>
<td>222444005</td>
</tr>
<tr>
<td>Western</td>
<td>333</td>
<td>Mongu</td>
<td>555</td>
<td>Mongu HC</td>
<td>006</td>
<td>333555006</td>
</tr>
</tbody>
</table>

In many countries, health facilities may already have a unique identifier assigned to them. Even in these instances, it is recommended that the numbering scheme described above be used for surveys, since many facility codes are long or are made up of a completely randomized set of numbers. Still, local facility codes may assist in identifying a facility at a later stage in a survey, so the LIAT data entry tool has a space to record them.
**Survey Preparation**

Once an agreement between stakeholders has been reached to conduct a supply chain assessment, and adequate resources have been secured, a significant amount of planning must occur before data collection can begin. This includes staffing, selecting data collectors, obtaining authorization to visit facilities, organizing survey logistics (e.g., transportation to sites), and preparing materials.

**Staffing**

Assessments generally include the participation of:

- trainers;
- data collectors, including team leaders;
- a survey coordinator;
- survey monitors (optional);
- a data analyst (optional); and
- data entry staff.

Determining personnel requirements is a critical step in ensuring that an assessment stays within its established timeline and budget. Depending on the size of an assessment, it may be necessary for program staff who are familiar with the technical area being assessed or who have prior experience in quantitative assessments to be part of the team. Local team members are also helpful in identifying data collectors. Often, outside data collectors can be recruited from a local university, ministry of health, or nongovernmental organization. A data entry staffer may also be needed and can be outsourced if the program staff is unavailable for this task.

Additionally, data collectors may function as team leaders in the field to help with daily quality control checks (explained in detail below) and general coordination. Team leaders can be selected from the pool of data collectors based on their understanding of the assessment tool and data collection protocols. A good time to assess the qualifications of team leaders is during piloting of the assessment tool (also explained below) at practice facilities.

If local program staff or external technical assistance is not obtained for the assessment, a locally hired survey coordinator will be needed. Survey coordinators are contracted to oversee the entire data collection process and to provide guidance to the data collection teams. Survey coordinators will need to be supervised by the person in charge of the activity or the technical lead. Survey coordinators may also be tasked with analyzing data and reporting the results of the study. In some cases, it may be necessary to contract separately for a data analyst to assist with analyzing the data. Sample scopes of work for both the survey coordinator and data analyst positions are provided in Appendix 5.

**Selection of Data Collectors**

Selecting who will administer the survey is important to the success of the activity. A person’s background in health, previous experience with surveys, familiarity with the geographic area in question, and ability to speak the local language are all important considerations. Familiarity with supply chain management and the health area being evaluated is often the primary factor in choosing data collectors. Program personnel who have experience with program monitoring and evaluation (M&E) activities and who understand internal administrative and financial rules will also facilitate the progress of an assessment.
The data collection team should include personnel from the ministry of health (MOH) involved in implementation of the logistics system. Inclusion of MOH staff will facilitate the data collection process by granting a team access to key local government personnel and using their knowledge of government processes. It is also quite valuable to have MOH personnel involved in the data collection process so they can get a first-person look at the situation in the field. This may aid a program’s efforts in advocating for change based on assessment results. For particularly large surveys, staff outside the program or MOH may need to be recruited. Students or faculty at local universities or teaching hospitals make good candidates, especially if they are involved in public health. Sample job descriptions for the recruitment of data collectors and data entry staff are provided in Appendix 6.

Regardless of their background or affiliation, it is critical that data collectors be available and can commit to the entire data collection period. Prior experience on other surveys does not eliminate the need for data collection training, which is specific to each survey. It is useful to have potential substitute data collectors attend the training to ensure that last-minute personnel substitutions can be made if the need arises.

The steps to take when acquiring survey staff are:

1. Determine local staff resources and the number of data collectors needed for the survey, and choose whether a survey coordinator and data analyst external to the program should be contracted.
2. Advertise for and select a survey coordinator (and data analyst, if needed) for the entire survey.
3. Advertise for data collectors. Plan to hire no more than three to four data collectors per team with the expectation that each team will visit an average of two facilities per day. The number of teams required will depend on the overall number and geographic distribution of the facilities and time dedicated to data collection.
4. Develop contracts and statements of work (SOWs) for all external survey staff, and ensure that external contractors understand their commitment for the length of the survey process.

**Planning for Survey Logistics**

It is essential to have a designated vehicle and driver for each data collection team. Multiple vehicles may have to be hired for a large survey. Borrowing vehicles from outside projects or a ministry of health may seem like a good way to save money, but partner agencies’ priorities can change and may result in a sudden requirement to return a vehicle. Vehicles must be committed for the entire duration of the data collection phase, including contingency plans in the case of breakdowns and funds for fuel.

Planning a field visit itinerary that ensures the least distance to travel between facilities and appropriate areas for evening lodging (e.g., midway between the last facility to be visited on one day and the first to be visited on the subsequent day) is an important way to control expenses and maximize the use of time spent in the field. With this in mind, a schedule should be determined ahead of time so that each data collection team knows which location to cover at the beginning of any given day and where it will need to be after data collection is completed for that day. The first day of data collection is usually spent visiting the Regional Medical Officers to ensure that they are well aware of the data collection efforts occurring in their area. District Medical Officers should also be visited before beginning data collection in each new district. This protocol visit will further facilitate cooperation from the health facility personnel. Identifying appropriate places to obtain fuel and meals should also be considered when planning a day’s activity.
The following steps should be taken when arranging survey logistics:

- Make sure that the location of each facility that has been selected to participate in the survey is known, including how to reach it (what roads to take). Prepare a draft schedule of field visits for each team.
- Arrange lodging for the data collectors; alternatively, data collectors can make arrangements themselves.
- Arrange for questionnaires to be returned to the survey coordinator.
- Contact local government entities, as appropriate, to inform them that a survey will take place.
- Obtain letters of introduction from the MOH for the data collection teams.

**Materials Needed for Training and Field Work**

In addition to paper and pens, there are a number of items that will need to be secured before an assessment begins. A complete list of materials needed for survey training and field work is provided in Appendix 7.

Computers should be designated or rented for data entry and analysis, including one computer for each person entering and analyzing data. The computers should be equipped with software that is compatible with the needs of the assessment (e.g., Microsoft Access for data entry and SPSS for data analysis). Paper-based surveys may require a significant number of copies, so it is thus important to secure access to an office photocopier or prepare to send out copy jobs to local vendors. In areas where electricity is an issue, it is essential to check whether generator backup is available to avoid delays.

A number of electronic devices can assist in the data collection and data entry process. These devices can include rugged laptops, personal data assistants (PDAs), and mobile phone technology that enable data collectors to complete electronic questionnaires. An assessment plan that includes use of these devices should include at least one device per data collection team, although more devices per team would allow data collectors to go to separate locations within a facility and collect data more rapidly. Additionally, if GPS coordinates are being captured for electronic mapping, each survey team should have a GPS device. In some cases, PDAs or cell phones may have GPS capability built in.

Each team should have at least one designated mobile phone for communicating with the survey coordinator or country office. In most cases, data collectors will have their personal mobile phone with them in the field, so providing phone cards to team leaders is recommended to encourage them to communicate with the study coordinator and other teams when issues arise.

**Data Collection Training**

Training data collectors is a key component of an assessment to ensure complete, high-quality results. This section provides guidance on training data collectors for a LIAT-enabled assessment and should be used in conjunction with the LIAT Trainer’s Guide provided in Appendix 8.

**Timing**

Training should be scheduled approximately six months or more in advance and in coordination with all partners involved, including the Ministry of Health (MOH) or host-country government counterpart. The training event itself should take place the week directly before data collection is to
begin. Time is a major consideration, as invitations and notification letters sent outside the capital city can take a month or longer to reach their intended destinations. After invitation letters are sent, a follow-up phone call is recommended to confirm participants’ availability. Data collection training generally lasts four days, including a pilot test of the tool.

**Trainners**

Trainers should be knowledgeable about the data collection instrument, experienced in the data collection process, and comfortable conducting training. Usually, two trainers are sufficient, but more may be included. Prior training experience is advantageous but not mandatory. When GPS devices are being used to collect the geographic coordinates, one of the trainers should be knowledgeable about GPS and GIS.

**Participants**

Data collectors and survey monitors (if used) should be identified well in advance of the training event and data collection activity. It is highly recommended that a national assessment include regional MOH personnel, district MOH personnel, or host-country government staff members who are knowledgeable about the supply chain system and who work in the geographic area where data will be collected. The number of participants will depend on the number of data collection teams required to carry out the assessment. Generally, teams are made up of two data collectors, although some assessments may use up to four data collectors per team so they can further split into two-person teams in the field, as necessary. However, teams comprising four data collectors are not recommended due to the potential for logistical problems and the additional costs this entails. Taking into account budgetary considerations, monitors may travel with a team for the first few days of data collection, or they may visit several teams within a smaller area.

**Other Participants**

Generally, senior members of the MOH, host-country government, implementing organization, or primary donor should give welcoming remarks and opening comments. Some of the same stakeholders may participate in the training. It is also necessary that a technical advisor or equivalent provide an overview of the in-country logistics system to improve the participants’ understanding of the data they will be collecting.

Data entry personnel who will enter data into a database after the survey can benefit from participating in the training to acquire a greater understanding of the tool and data. They can also serve as data collectors, which will help them better apply their experience with the tool to the task of data entry.

Monitors should also participate in training to fully understand the questionnaire and the conditions they will face in the field, even if they have served as monitors in other surveys.

**Venue**

When choosing a venue for the training, the following should be taken into consideration:

- Proximity to where participants are staying and the implementing organization’s local office.
- Whether lunch and tea breaks are included.
- Room size in relation to the number of participants.
- Whether extras, such as projectors and flip charts, are included in the price of space rental.
The training will be much easier on participants and trainers if the venue is located near where they are staying (for those arriving from out of town) and the implementing organization’s local office. Hotels are ideal because they usually have conference rooms, as well as a restaurant for lunch and tea breaks. Holding the training close to the implementer’s office will make it easier to carry training materials, make photocopies, retrieve extra supplies, and complete other administrative tasks. The room should be large enough to accommodate all participants easily, but not so large as to require participants to shout. It will be less expensive if the local office can provide a projector, flip chart, laptop, and any other materials.

**Materials**

**Handouts and Supplies**
Materials should be purchased beforehand for all participants (reminder: see Appendix 7 for a sample list of materials needed). All handouts should be printed prior to the training, again before the pilot test, and last, when the tool is finalized before the participants leave for data collection. Participants should be given a binder or folder to keep their handouts organized and in one place. Handouts can either be included in the binder before distribution to participants or they can be handed out daily for the participants to place in their binders. If handed out daily, handouts should be organized in a logical fashion. If draft versions are given out, it is essential to collect and recycle them before the final versions are provided so that no old versions are accidentally used for data collection. Trainers will need to organize revised printed handouts as the training progresses and in time for participants’ use.

**Products and Forms**
Samples of products that will be included in the survey should be purchased or borrowed beforehand for the participants to become familiar with packaging, units of count, strength (if applicable), and other details. Examples of stock cards, requisition vouchers, and other logistics forms being used in-country should also be given to participants.

**Schedule**
A training schedule is an important tool for training sessions. The training usually lasts four days and is held from 8:30 AM to 4:00 PM (including a one-hour lunch and two tea breaks) each day. An illustrative schedule can be found in Appendix 9. That schedule can be amended, but the sessions should be kept in the order shown because they are purposely arranged for practical reasons. Sessions must start on time and stay within their allotted time or participants will need to stay late to cover all material. It is recommended that this principle be included in the training norms (refer to the trainer’s guide for suggested norms). If an individual or a group of participants arrives late, trainers will need to stay late with them to be sure they understand what they missed.

**Conducting the Training**

**Trainer’s Guide**
The trainer’s guide included in the toolkit that this guide introduces serves as a step-by-step tool for conducting training sessions, including all course content.
**Training Objectives**

It is important to establish training objectives for participants. The following are examples and can be adapted as necessary:

By the end of the training, participants will be able to:

- Describe the purpose and objectives of the assessment.
- Understand and use the LIAT to collect data on logistics management of health commodities.
- Describe the team’s responsibilities in conducting the assessment.

**Tips for Trainers**

Trainers should always be prepared and should adhere to the objectives and goals of the course. They should encourage active participation while keeping participants on topic and offering praise and recognition. Giving real examples from past assessments is the best way to enhance participants’ understanding.

**Trainer Tool Options**

Trainers may choose use PowerPoint, overhead projectors, or simply speak about content. Using visual aids, such as products and stock cards, is also effective for participant comprehension.

**Survey Manual**

The survey manual serves as a resource for data collectors during the training and in the field. It contains an overview, as well as sections on team member requirements, site selection, data organization, ensuring quality, the data collection tool, interview skills, and logistics indicators. A sample survey manual is provided in Appendix 10.

**Pilot Testing of the Survey Instrument**

A pilot test will allow data collection teams to practice their newly learned skills in collecting data with the LIAT and, if needed, using GPS devices. The pilot test enables data collectors not only to experience what is likely to occur in the field, but also to identify potential obstacles, issues, and questions prior to real data collection. Pilot sites should be selected, notified by a government official, and confirmed in advance. It is best for them to be in the same area as the training is being held or no more than an hour’s drive away. Each team should visit up to two health facilities and should take no longer than four hours to finish. After the pilot test is complete, teams will return to the training venue and share their experiences and consider revisions to the data collection tool, as deemed necessary. The revisions will result in a final tool that is adapted to the country context.

The pilot is also the first time data collector teams will work together. Team members should decide who will carry out each task (e.g., conducting the interview, taking a physical inventory, completing a stock status table). Often, team members take turns to experience each element of the assessment.

**Data Collection Scenarios**

Due to the subjective nature of some questions, data collectors will often come across a situation in the field that can be interpreted in different ways or may not be fully covered in the training. It is impossible to think of all scenarios; however, it will be helpful to contemplate these potential obstacles and provide examples during the training. The following real examples could be reviewed on the last day of the training to assist data collectors in how they may answer the question.
• **Storage Conditions**
  - Question: Should products that are stored in the drawer of a staff member’s desk or in a small cabinet at a health facility be assessed using the indicators of storage conditions?
  - Answer: Yes. Although a drawer or small cabinet is not considered a storeroom, it should still be assessed. Use of the drawer should also be noted in the comments section.

• **Water**
  - Question: If a health facility purchases water and keeps it for use for hand washing, should this be considered as operational water on the day of the visit?
  - Answer: Yes. Although it is not from a pipe, well, borehole, or stream, it is still considered an operational way for the health facility to obtain water.

• **Roads**
  - Question: If the road to a health facility is unpaved and in bad condition, is it considered navigable?
  - Answer: It depends. Generally, if the team was able to drive up to the facility despite the poor state of the road, it should be considered a navigable road.

**Team Overview and Mapping for Data Collection**

In this session, teams will sit together and review site assignments and the data collection schedule. Together they should map out what facilities they will visit on what day, keeping in mind that large facilities will take longer for data collection than will smaller ones. Having a data collector from the area will be helpful in determining the logistics of traveling to facilities that may not be on a map.

**Team Leader Training**

Each team should identify a team leader. The team leader will have extra responsibilities to ensure that surveys are complete and carried out according to instructions. Guidelines for team leaders are outlined in the LIAT Survey Manual, and a sample checklist for team leaders can be found in Appendix 11. Trainers should sit with the team leaders to review the checklist and their responsibilities. This should be during the session on data collection details, held on day four of the training.

Team leaders are also responsible for labeling envelopes with the unique identification number and province, state, or region for each facility to be visited. After a visit to a facility, the team leaders should place final surveys in the envelope and ensure that they are returned safely to the survey coordinator. Team leaders should also be prepared to debrief with the survey coordinator to discuss the data collection process and any outstanding issues.

**Monitor Training**

Similar to team leaders, monitors have extra responsibilities to ensure the quality of surveys. Monitors answer questions teams may have, troubleshoot problems, and ensure that data are being collected according to instructions. The monitor’s checklist can be found in Appendix 11. Trainers should sit with the monitors and review the checklist and their responsibilities. This should also be during the data collection session on day four of the training. Team leader and monitor trainings can be done simultaneously with each trainer.
Data Collection

Data collection is one of the most important aspects of a health facility survey. The process can take from one week to several weeks, depending upon the sample size, the number of data collection teams, and the distribution of the facilities. Data collectors should have a clear understanding of the objectives of the survey, including why it is being done, by whom, and how it will benefit the health facilities. Although each team is required to visit a set number of health facilities within an established time frame, it is equally important to be careful while collecting data in order to maintain data quality and integrity. Data collection efforts will essentially be worthless if data quality is compromised and the results of the survey are questioned. The sections below describe the process that should be followed to ensure that high-quality data are captured.

Organization of Data Collection Teams

Data collection teams should be organized so that data can be collected efficiently in terms of the time and resources it takes to conduct surveys and according to the specified data collection schedule. As noted earlier, teams should include at least two data collectors so individuals can alternate between asking survey questions and recording responses. Teams of two data collectors are also advantageous because they require fewer resources and can accommodate the addition of local MOH personnel to the team for facilitating access to health facilities.

Teams comprising more than two team members can be useful if facilities in the study are large or have various departments or wards (like hospitals). That is, more ground can be covered in the same amount of time. For example, while two data collectors are conducting an interview, a third can engage the storekeeper to begin a physical count of products, especially if there are many commodities to assess. Teams of more than three individuals are not advisable unless team members can visit two facilities simultaneously. Subdividing a group to cover more facilities can be useful, but it also carries a number of potential pitfalls. If teams are sharing a vehicle, each team will have to wait to be picked up or dropped off at a time when they could otherwise be moving toward another facility. Another drawback to using this “pick and drop” method is the possibility of a vehicle breakdown, stranding one or both teams in unfamiliar surroundings without a vehicle. The best use of two or more additional team members would be to work independently of the first group, in their own designated vehicle, and then meet up in the evenings to discuss survey results.

Each team member is responsible for making sure that questionnaires are complete, all answers are clear and reasonable, and hand-written answers or comments are legible. Team members should review the questionnaire for completeness before departing the facility so that missing information can be gathered without having to return to the facility later. It is also highly recommended that the data collectors obtain a functioning telephone number of the facility in-charge or the person interviewed in case the team needs to call the health facility for clarifications or to obtain any information missed during the facility visit.

Team Leaders and Survey Monitors

Team leaders are data collectors who take on the additional responsibility of checking surveys to make sure that data collected at the facility are recorded completely and accurately. Team leaders may use checklists to ensure that all requirements of the data collection process are being met. At the end of each day, team leaders should lead a review of the data collection process to record any additional information or issues relevant to the study.
Team leaders should also make certain that routine administrative processes are carried out to facilitate the data collection process. These may include ensuring that teams arrive at the facilities with ample time to administer the survey, meeting with local government officials upon arrival and departure, providing per diem to local personnel assisting in the study (if appropriate), and maintaining contact with the study coordinator or monitors.

Survey monitors add an additional layer of quality assurance to the data collection process. Survey monitors may accompany a data collection team to the field in order to handle questions, troubleshoot any data collection issues, and ensure that data quality checks are being performed daily. Survey monitors typically stay with a team for only the first few days of data collection, but the additional oversight they provide to the overall survey is invaluable. Ideally, there are multiple monitors so that all data collection teams are visited during their first few days in the field. Using survey monitors to their full potential will require additional resources and must be carefully considered for surveys with limited funding. Sample quality checklists for the team leaders or survey monitors are provided in Appendix 11.

**Survey Submission Process and Call-In Schedule**

In addition to organizing teams to include team leaders and deploying survey monitors to the field, other practices can be employed during a survey to help ensure data quality. Data collection teams may be instructed to submit completed surveys to the survey coordinator after the first few days of data collection. This way, surveys can be reviewed and any potential data-capturing errors or questions can be identified for immediate follow-up. This process is especially important during the first few days of data collection, when mistakes and or data collection errors can be corrected before too much time and too many resources have been used. Submitting completed surveys for a timely review by the survey coordinator is particularly important when a survey’s budget does not allow for the use of survey monitors. It can also prove to be an inexpensive way to monitor progress in the field once survey monitors are recalled.

Data collection teams should submit originals of the completed surveys and retain copies in case the originals are lost. Completed copies can be sent using a reputable courier service. Such service may be offered through the national airlines or print media. Whatever the method of submitting the completed surveys, data collection teams should consider the timeliness of the service; in some instances, it may be better to simply return completed surveys in person at the end of the field work. Before departing for the field, each team should have detailed instructions on how and when it will need to submit completed surveys.

Related to submitting surveys for review, telephone calls should be scheduled between the data teams and survey coordinators (or survey monitors). Teams should expect calls from the survey coordinator or monitors on a predetermined date and time. These calls serve as a time to discuss feedback on the previously submitted surveys, relay important instructions on the data collection process, or determine a team’s progress toward visiting the facilities according to the site visit schedule. Call-in may be more frequent during the first week of data collection, especially if an assessment activity chooses not to use survey monitors. Data collectors should be encouraged to call in with questions or concerns at any point during the data collection process. Each team should be supplied with a call-in schedule so calls can happen on schedule and without problems.
Data Collection Protocols
Completing a survey at a primary health facility usually takes between two and four hours, depending on the size of the facility. When they have planned ahead, teams should be able to visit at least two primary health facilities each day. Hospitals and health facilities at the secondary and tertiary level may take a full day. Team leaders should assist their team in adhering to the site visit schedule to complete the requisite number of facilities in the time allotted.

Local Government Briefing
Before conducting a survey in a new administrative area (e.g., region or district) the team leader should bring the entire team for a visit with the local government office to brief officials on the assessment activity. Letters of introduction and a list of health facilities to be visited should be shared with officials at this point, and any potential issues should be discussed in detail and resolved prior to beginning data collection. If local government personnel are needed for assisting with the data collection, it is essential to describe how they will be assisting and for how long.

Once data collection is completed within this government area, debrief the same government officials to let them know that the team has completed the work and provide them with an overview of the findings for that area. Observations shared with local government officials about visited facilities should remain neutral, touching on both good and bad aspects of the supply chain system being evaluated. It is important to keep individual and facility names confidential as much as possible during debriefings.

Replacing an Inaccessible Facility
As noted in the sampling section of this guide, some survey teams may encounter facilities that are closed or otherwise inaccessible. In these instances, a decision will have to be made to replace the facility. Replacing the facility can be the responsibility of the study coordinator or the team leader, depending on the organization of the assessment. In most instances, a team leader should contact the study coordinator before selecting a replacement facility. The study coordinator will work with the team leader to find a replacement facility that matches the characteristics of the facility to be replaced. Often, this will be a facility that is in close proximity to the team to minimize the drive time to the replacement facility and avoid falling behind schedule. If a facility replacement list has been established (as described in the Steps in Sample section), team leaders can select the nearest health facility on that list. Team leaders should first try to contact the study coordinator to discuss the decision to replace the facility. If, however, the study coordinator is not available, team leaders should thoroughly document the reasons behind replacing a health facility.

Capturing Geographic Coordinates
Using Geographic Information Systems (GIS) facilitates the identification of logistics issues that may be specific to certain areas of a country. GIS adds value to information that is obtained with the LIAT by increasing the ways the data can be used; it also provides a simple method for visually demonstrating results, the importance of which is discussed briefly in the last section of this guide.

Understanding how geography, both in its human and physical dimensions, affects the functioning of the logistics system will provide decisionmakers and logistics managers with a more comprehensive set of information to assist them in their work. For example, if stockouts in health facilities are observed to be clustered in a particular area, there may be a common cause, such as
poor road conditions. Knowing the spatial distribution of logistics indicator values at the health facilities allows for a better understanding of challenges like these and enables targeted decisionmaking and action to improve system efficiency.

In assessments where geographic coordinates are being captured, a GPS device or a GPS-enabled device (like a Smartphone) can be used for this purpose. In some cases, geographic coordinates may have already been documented by the client or can be found in previous assessments. Those collecting geographic coordinates during a survey will also require GPS/GIS software to map data. Guidelines for use of GPS devices and GPS/GIS software are included in the toolkit this guide introduces.

**Data Entry**

Data entry will begin once surveys are delivered from the field and all necessary checks and corrections have been made to the survey forms. Data entry personnel should be able to work without interruption until the surveys are entered from the data entry tool into the database. In most cases, the completed surveys will arrive from the field intermittently, so data entry staff will likely work for a day or two and then be on call for when the next batches of surveys comes back from the field.

The value added of using electronic data-capturing devices such as PDAs or cell phones during the LIAT is that it eliminates the need for data entry staff. Data from electronic surveys can be directly downloaded into a master database, which can then be checked by the survey coordinator or data analyst. Savings in the overall cost and time it takes to enter the data are typically realized here.

**Data Entry Staff Training**

Before data entry personnel begin transposing data from the paper-based survey to the data entry tool, a detailed training on data entry protocols and orientation to the data entry tool will be required. Protocols for entering data are described in the Data Entry Guidelines, available as part of this toolkit.

Generally, data entry training is quite simple. Its purpose is to orient the staff to data entry procedures and provide them with hands-on practice entering data. Ideally, the data entry staff will have attended the data collector training and perhaps even participated in the data collection process. If, however, the data entry team is unfamiliar with the questionnaire, it is important to orient them to the survey instrument and instruct them on its “skip logic” (i.e., the path that respondents take through a survey based on the answers they give to certain questions and other technical aspects). The survey coordinator or data analyst should sit with the data entry staff as they begin to enter the data to answer questions and provide further instructions as needed. A quality check of the data should be performed early to detect any errors caused by the data entry process. Under the close supervision of the survey coordinator or data analyst, data entry personnel can begin entering completed questionnaires. Alternatively, if practice is warranted before actual completed surveys are available, data collected from the pilot sites can be used as a proxy. In this case, it is essential to erase practice records or create a new database before beginning with completed surveys from the actual survey sites.
Data Entry Quality Assurance

Having quality data will ensure that the results of the study are reliable and reflective of the true conditions in the field. A number of data quality controls are employed in the data entry tool, such as programmed skip patterns and pop-up reminders. These controls are outlined in the toolkit’s Data Entry Guidelines and are designed to assist the data entry staff in avoiding errors that could undermine the reliability of the results.

In addition to these quality control measures, it is strongly recommended that a double data entry model be used to ensure that the data entered are accurate. Double data entry is a quality control measure that involves having two data entry staff entering the same data into two separate databases, and then comparing the databases for discrepancies. If discrepancies between the two databases are identified, the response from the questionnaire is manually rechecked and the change is made to ensure that correct information appears in both databases. A Microsoft Excel document designed to check for discrepancies between the two databases is provided in the toolkit, and instructions on its use can be found in the back pages of the Data Entry Guidelines.

Data Analysis

Once survey data have been entered into a LIAT database using a data entry tool, and the data have been checked for missing elements or entry errors, the survey coordinator or data analyst should begin to produce preliminary results for debriefing in-country stakeholders. Data analysis can be challenging due to the limited time that is typically allowed for calculating the data and organizing results in an easy-to-understand format.

Standard Indicators for LIAT Analysis

Analysis of data collected with a LIAT will generally follow the associated LIAT indicators summarized in Table 4 and provided in complete detail in the document, Monitoring and Evaluation Indicators for Assessing Logistics Systems Performance, available as part of this toolkit. These indicators are designed to address the logistics issues that are of most interest to stakeholders. They can also be used as part of the assessment planning process by developing an analysis plan and showing interested parties what information will be available to them through the LIAT. Although the standard LIAT indicators are comprehensive and are recommended for presenting preliminary data, they are not the only indicators that can be used to analyze the data collected in a standard assessment using a LIAT. Additional indicators can be developed to fit the particular needs of a product area or logistics program, for example, determining the percentage of facilities where different health commodities are delivered together.

Table 4 shows a list of indicators taken from a recent assessment in which the LIAT was used. These indicators are the most common ones used for measuring the status of a logistics system and the quality of the source from which data will be collected. Although the list of indicators is introduced in this section, indicators are also an important part of the assessment planning process. Discussing the list of indicators with stakeholders before the assessment begins will inform everyone concerned about the potential resources needed for data collection (i.e., the time and staff it takes to collect the data and how that equates to costs) and what results they can expect from the activity.
Table 4. List of Sample Indicators for Evaluating a Logistics System

<table>
<thead>
<tr>
<th>Indicators</th>
<th>Data Source(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Training</strong></td>
<td></td>
</tr>
<tr>
<td>Percentage of personnel who learned logistics through formal training</td>
<td>Respondent</td>
</tr>
<tr>
<td><strong>Logistics Management Information System</strong></td>
<td></td>
</tr>
<tr>
<td>Percentage of facilities with ledger books available and updated by product</td>
<td>Ledger books</td>
</tr>
<tr>
<td>Percentage of facilities with accurate stock balances in ledger books</td>
<td>Ledger books and physical inventory count</td>
</tr>
<tr>
<td>Percentage of facilities using LMIS forms for reporting and ordering</td>
<td>Respondent</td>
</tr>
<tr>
<td>Percentage of facilities regularly submitting LMIS forms</td>
<td>Respondent</td>
</tr>
<tr>
<td><strong>Inventory Control</strong></td>
<td></td>
</tr>
<tr>
<td>Percentage of facilities that ordered according to maximum stock levels</td>
<td>Respondent</td>
</tr>
<tr>
<td>Average lead time for ordering all commodities</td>
<td>Respondent</td>
</tr>
<tr>
<td><strong>Transportation</strong></td>
<td></td>
</tr>
<tr>
<td>Percentage of facilities where commodities are collected by facility staff</td>
<td>Respondent</td>
</tr>
<tr>
<td><strong>Supervision</strong></td>
<td></td>
</tr>
<tr>
<td>Percentage of facilities that report receiving logistics supervision visits</td>
<td>Respondent</td>
</tr>
<tr>
<td><strong>Storage</strong></td>
<td></td>
</tr>
<tr>
<td>Percentage of facilities that maintain acceptable storage conditions</td>
<td>Visual observation</td>
</tr>
<tr>
<td><strong>Stock Status</strong></td>
<td></td>
</tr>
<tr>
<td>Percentage of facilities experiencing a stockout of commodities on the day of visit</td>
<td>Ledger books and physical inventory</td>
</tr>
<tr>
<td>Percentage of facilities experiencing a stockout of commodities in the previous six months</td>
<td>Ledger books</td>
</tr>
<tr>
<td>Average duration of stockouts for commodities in the previous six months</td>
<td>Ledger books</td>
</tr>
<tr>
<td>Average months of stock on hand for all products</td>
<td>Ledger books and physical inventory</td>
</tr>
</tbody>
</table>

**Standard LIAT Analysis Process**
Data analysis begins immediately following the entry and “cleaning” of all completed surveys; analysis should not be done when data from surveys still need to be added to the database. Questions or issues with surveys will need to be resolved before results can be shared with stakeholders.

The time it may take a data analyst to process data greatly depends on the software available for data analysis and when the results are needed. Statistical software packages, such as SPSS, SAS, and
STATA, are designed to allow data analysts to deal with large amounts of data in a relatively short time, as long as the operator is familiar with the software. Other software, such as Microsoft Access or Excel, can be used for data analysis, but dealing with data collected from large surveys may be cumbersome using these relatively simple tools and, without preprogrammed cells for calculations, the analysis process may take some time to complete. Knowing what software analysis tools will be used should reveal how many days will be needed for analyzing the data. A typical scenario where the data analyst is familiar with SPSS can produce preliminary results within two to three days.

For SPSS users, a standard analysis document is available in Appendix 12. This document explains how the indicators are calculated and suggests SPSS syntax to use in the analysis.

Box 6. Chapter Summary: Using the LIAT

- The Logistics Indicators Assessment Tool (LIAT) is a quantitative data collection instrument used to conduct surveys that assess health commodity logistics system performance and commodity availability at health facilities.

- Using the LIAT to conduct an assessment based on experimental survey design (i.e., data collection from an intervention group and a control group) will produce the most robust results, but using a more cost-effective non-experimental design (i.e., data collection from an intervention group only) can still produce extremely valuable and accurate data for decisionmaking in supply chain management.

- Because it is rarely possible to visit all facilities serviced by a supply chain, a representative sample should be chosen for data collection. Based on feasibility, survey organizers should agree on how many facilities to randomly select at each level of the system and across what geographic area in order to support their efforts to make evidence-based recommendations about the entire system.

- An assessment team is made up of data collectors (including leaders for each data collection team), a survey coordinator, and data entry staff. Optional personnel include survey monitors and data analysts. Trainers should be engaged to train all team members appropriately in the specific data collection needs of the survey, regardless of the participants’ previous experience.

- Data collection at a primary health facility using the LIAT usually takes between two and four hours. Teams should be able to visit at least two primary health facilities each day. To better ensure accessibility, facilities should be informed ahead of time about the visit, and, before conducting a survey in a new administrative area, the team leader should bring the entire team for a visit with the local government office to brief officials on the assessment activity.

- Controlling the quality of data collected is an important daily activity. Data collectors should review their work before leaving a facility, and team leaders should facilitate a daily review of all completed LIAT forms to ensure clarity and completeness. Collecting geographic coordinates using global positioning software devices can facilitate a better understanding of geographic trends that affect areas served by a supply chain.

- Data may be submitted for entry on a rolling basis (using the services of a courier) or upon return from field visits. Use of electronic data collection devices, such as PDAs, can eliminate the need for data entry staff and reduce the amount of data “cleaning” that must be undertaken to avoid errors.

- Data analysis is best conducted using an establish software package. Standard LIAT indicators allow for analysis of the logistics issues that are of most interest to stakeholders, including training, logistics management information systems (LMIS), inventory control, transportation, supervision, storage, and stock status.

See Appendix 13 for a summary of preparatory steps that assessment organizers should take before beginning training, data collection, and data entry.
Presenting Results

Assembling Key Information

In most assessments, preliminary results are presented to in-country stakeholders directly following the completion of data analysis, and a final technical report is issued shortly thereafter.

When the LIAT and LSAT are used jointly in an assessment, information from both sources should be presented to best depict the situation on the ground. If the LIAT is used independently, it is useful to gather and provide additional information as background on how the logistics system being assessed is designed. Similarly, assessments that use only the LSAT should be complemented with supplemental data on supply chain efficiency, whether gathered from recent studies or a limited set of site visits.

Presenting the Results

The presentation of results should respond to all of the objectives and concerns that stakeholders expressed at the outset of assessment planning. Although it is important to provide evidence in easy-to-understand language, presenters should be careful to avoid simplifying their information to the point of being less useful or even condescending. Ideally, reports should be available in local languages for non-English-speaking stakeholders.

Visual representations in presentations and technical reports should also be easy to understand. Whereas data-rich, complex graphs and charts might be appropriate for fellow evaluators, counterparts are more likely to discuss, share, and act upon results that are provided through clearly labeled graphics, data tables, and with other media (e.g., photos, maps, etc.).

Presenting the results of an assessment should be done well in advance of their intended use. Far too often, assessments are conducted immediately before a strategic planning session or drafting a program’s work plan. Assessment planners should budget ample time for presenting, writing, and disseminating results so that stakeholders have an opportunity to respond to the findings before using them for planning and decisionmaking.

Last, authors of in-country presentations and technical reports must be mindful of the potential consequences that assessment results entail. For example, despite efforts to ensure the confidentiality of data, some individuals may be blamed for specific logistics weaknesses that were detected. Or an outside service provider (i.e., a private company contracted to transport commodities) may strongly dispute results that it feels could reduce its likelihood of obtaining future contract opportunities.

In cases where a system weakness is directly attributable to a specific unit or organization, the findings should be shared privately in advance with that organization and the manager or supervisor in charge. Any conclusions drawn should be validated during the assessment and presented with supporting data and documentation.
Mapping Results

Simple maps are a particularly effective way to present data trends that are identified during LIAT analysis. For example, using a map to show facilities where frequent commodity stockouts occurred and those that experienced infrequent or zero stockouts can clearly indicate regional effects and provide a focal point for discussion between stakeholders. Maps of this type are also easier to understand for decision makers and other important audiences whose members may be less familiar with logistics principles. However, concerns of facility confidentiality must be considered when presenting results in this manner.

A number of different Geographic Information Systems (GIS) software packages are available for map making. In particular, there are open source GIS software options that are simple to use and free-of-cost. DIVA-GIS (available at www.divagis.org) is one example of software that can be used to display LIAT data visually and conduct some initial spatial data analysis. For more advanced spatial analysis, a tool such as tQGIS is useful.

Storing Data and Results for Follow-On Activities

Documentation from the assessments should be carefully retained to enable follow-on assessment and, ultimately, an understanding of supply chain changes over time. While it is recommended that all documents supporting the final assessment report should be saved, particular attention should be paid to the finalized database (often stored in SPSS), LSAT and LIAT questionnaires, technical report, and facility list (including replacement facilities). With these three documents, a follow-on assessment team will be able to visit the same sites and compare newly obtained data to previous information.

The stakeholder that commissioned the activity should receive all three of these documents. However, similar to the issue of confidentiality surrounding sharing preliminary results, consideration should always be given to ensuring the continued confidentiality of interviewees and facilities from which data were collected.

Box 7. Chapter Summary: Presenting Results

- When the LIAT and LSAT are used jointly in an assessment, information from both sources should be presented to best depict the situation on the ground. If the LIAT is used independently, it is useful to gather and provide additional information as background on how the logistics system being assessed is designed. Similarly, assessments that use only the LSAT should be complemented with supplemental data on supply chain efficiency, whether gathered from recent studies or a limited set of site visits.
- Assessment planners should budget ample time for presenting, writing, and disseminating results so that stakeholders have an opportunity to respond to the findings before using them for planning and decision making.
- The presentation of results should respond to all of the objectives and concerns that stakeholders expressed at the outset of assessment planning. However, presenters should be mindful of the sensitivity of sharing preliminary results, particularly in the case of information that may compromise the confidentiality of data collection sites, or that have potential repercussions for staff members or entire organizations.
- Simple maps and other graphic representations are key ways of increasing stakeholders’ understanding of technical issues and facilitating the sharing of results with other concerned parties.
- Documentation from the assessments should be carefully retained to enable follow-on assessment and, ultimately, an understanding of supply chain changes over time.
### Appendix A

**Sample Activity Schedule for a Five-Week Assessment**

<table>
<thead>
<tr>
<th>Week</th>
<th>Sunday</th>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
<th>Saturday</th>
</tr>
</thead>
<tbody>
<tr>
<td>Week 1</td>
<td>STTA advisor arrives in country</td>
<td>LSAT/LIAT activity preparations; meet with various stakeholders</td>
<td>LSAT activity preparation; presentation finalization</td>
<td>LSAT activity: all-day event</td>
<td>LSAT analysis: optional continuation or processing results</td>
<td>LSAT analysis: identify gaps for follow-up; identify critical areas for LIAT</td>
<td>LSAT analysis and follow-up; LIAT preparations (optional as needed)</td>
</tr>
<tr>
<td>Week 2</td>
<td>Break</td>
<td>LIAT training preparation</td>
<td>LIAT training day one: data collection protocols, tool review</td>
<td>LIAT training day two: tool review, GPS</td>
<td>LIAT training day three: pilot test tool</td>
<td>LIAT training day four: finalize tool, prepare for field work</td>
<td>Data collectors, monitors, supervisor depart for field work</td>
</tr>
<tr>
<td>Week 3</td>
<td>Data collectors, monitors, supervisor depart for field work</td>
<td>Data collection; monitors and supervisor review data</td>
<td>Data collection; monitors and supervisor review data</td>
<td>Data collection continues without monitors</td>
<td>Data collection; finalize data entry tool/database</td>
<td>Break</td>
<td></td>
</tr>
<tr>
<td>Week 4</td>
<td>Break</td>
<td>Data collection; data entry training</td>
<td>Data collection; data entry</td>
<td>Data collection: data entry</td>
<td>Data collection; data entry</td>
<td>Data collectors return from field work</td>
<td></td>
</tr>
<tr>
<td>Week 5</td>
<td>Break</td>
<td>Debrief with data collection team leaders; data entry</td>
<td>Debrief with data collection team leaders; data entry</td>
<td>Data analysis; populate data tables; prepare for stakeholder debrief</td>
<td>Data analysis; populate data tables; prepare for stakeholder debrief</td>
<td>Stakeholder debrief</td>
<td>STTA advisor departs country</td>
</tr>
</tbody>
</table>
Appendix B

Determining a Data Collection Method for System Assessments Using the LSAT
Are key country-specific adaptations to the LSAT necessary before its use?

No

Can a group of 15–25 participants from the central and lower levels be convened for a period of 1–2 days?

Yes

Can a group of 10–25 central-level participants be convened for a period of 1-2 days, followed by 1-day sessions with lower-level personnel?

Yes

Discussion groups: central and lower levels combined

Discussion groups: central and lower levels separate

Key informant interviews

Combined approach: discussion groups first

Combined approach: key informant interviews first

• Were all intended participants present?
• Was information gathering complete?

Yes (to both)

No (to either)

Consider limited key informant interviews as an option for validating results.
Appendix C

Determining Survey Design Type for Facility-Level Assessments using the LIAT

Assumptions

Coverage
Supply chains providing nationwide coverage generally cannot be evaluated through experimental design because it is hard to identify a control group for this purpose. On the other hand, pilot programs and less-than-nationwide supply chains can often be compared to non-intervention areas in the same country with similar populations and commodity needs.

Data
Data that are sufficiently accurate for decision making are always required in supply chain assessments. In some cases, however, there is an added need to ensure that data are scientifically reliable enough to be published in a journal or subject to statistical scrutiny. In such a case, only experimental design is appropriate.

Funding
Efforts to control budget outlays are always important. In general, experimental design is costlier than non-experimental design because it expands the amount of data to be collected. This is not to say that cost-reasonable approaches to experimental design cannot be sought, or that programs with greater funding should always seek to conduct experimentally designed surveys.
What is the geographic coverage of the supply chain that will be assessed?

- Pilot intervention area
- Less than nationwide
- Nationwide

- What are stakeholder expectations for data?
  - Scientifically reliable (i.e., publishable)
  - Sufficiently accurate for decisionmaking

Are budget constraints a consideration?

- Yes
- No

What is the primary purpose of the assessment?

- Show impact: Pre-term or mid-term
- Show impact: Post-term
- Exploratory research

Has a pre-term and/or mid-term assessment been conducted?

- Yes
- No

Experimental Design: Pretest/Post-test

Non-Experimental Design: Pretest/Post-test

Non-Experimental Design: Post-test only
Appendix D

Determining Sampling Method for Facility-Level Assessments Using the LIAT

Assumptions

Funding
Efforts to control budget outlays are always important. Stratified random sampling is often costlier than systematic and simple random sampling because it may expand the amount of data to be collected. This is not to say that cost-reasonable approaches to stratified random sampling cannot be sought, or that programs with greater funding should always seek to employ stratified random sampling.

Sampling Method
All types of random sampling allow for analysis of different strata within a system. However, only stratified random sampling ensures that proportionate representation of facilities at each level of the system will be achieved, thus providing more robust results. Generally, with systematic sampling and simple random sampling, the numbers of each type of facility are not specifically controlled in the selection process, but valuable analysis of level-specific trends may be performed by sorting data into strata once they have been collected.

Non-probability sampling can be used for facility-level assessments, but it introduces a high risk of bias in the selection of facilities, and therefore, decreases the likelihood that results are truly representative of the entire sampling frame.
For what type of assessment is the sampling method being determined?

- System-level assessment (using the LSAT)
- Facility-level assessment (using the LIAT)

In determining health commodity availability (and the factors that support it), what facility level(s) will be emphasized?

- All levels
- Service delivery points

Are budget constraints a consideration?

- Yes
- No

How large is the sampling frame?

- > 1,000
- < 1,000

Sampling Method:

- Non-Probability Sampling
- Stratified Random Sampling
- Systematic Random Sampling
- Simple Random Sampling

Probability Sampling
Appendix E

Scopes of Work for Data Analysts and Survey Coordinators (LIAT)

SCOPE OF WORK

POSITION: LIAT Data Analyst Consultant

SUPERVISOR: Country Director or Survey Coordinator

SPECIFIC RESPONSIBILITIES:

- Participate in orientation by survey staff on survey implementation, including a review of the assessment protocol and tools. Participate in as much of the four-day training workshop for data collectors as possible.
- Participate in orientation by survey staff on the survey data entry program. Coordinate with staff on logistics for recruiting and training data entry staff. Train data entry staff using the MS Access database provided.
- Oversee data entry quality checks and make necessary revisions to dataset. Oversee the work of the data entry staff for the duration of the study.
- Convert the Access database to SPSS.
- Clean the database based on skip patterns and filters in assessment questionnaire. Send the completed Access database and SPSS data files to country office or project HQ for review.
- Create a comparison table using baseline and follow-up datasets. Set up SPSS data files for the merge (optional based on comparing data from multiple assessments).
- After HQ approves the dataset, tailor the standard SPSS syntax files to this survey.
- Carry out analysis following the data analysis plan and indicator table.
- Run statistical testing to determine the significance of changes between the baseline and follow-up periods.
- Assist the study coordinator in drafting the preliminary report, following the template provided.
• Respond to questions and/or requests for more information by the project’s country team and by the HQ staff as needed during the course of this survey. Keep the local team and survey coordinator informed of any changes in the timeline for delivery of products associated with this survey.

**ESTIMATED TIME NEEDED FOR THIS CONSULTANCY: 25–30 days**

**DELIVERABLES:**

• Access database file and SPSS files with cleaned, raw data.
• Comparison table for baseline and follow-up dataset merge.
• SPSS output tables and revised syntax files used for the analysis.
SCOPE OF WORK

POSITION: LIAT Survey Coordinator

SUPERVISOR: Country Director

SPECIFIC RESPONSIBILITIES:

- Take the lead in identifying data collectors and coordinate with USAID | DELIVER PROJECT office staff on logistics of training (i.e., training location, materials, etc). Facilitate a four-day training workshop for data collectors on survey implementation, including the assessment protocol and tools to be used.

- Take the lead in organizing field work logistics. This includes forming assessment teams from the data collectors who successfully complete their training, identifying supervisors or team leaders for each team, making site visit plans, coordinating vehicles and communications, and assigning regions and districts to teams.

- Supervise survey data collection for the duration of the survey (including on-site supervision in the first week, at a minimum). Ensure that sampling and data collection are conducted according to the guidelines provided by the M&E staff backstopping this survey.

- Supervise data analyst and provide general management of data entry component of the survey. This includes overseeing all aspects of data coding, entry, cleaning, and analysis.

- Draft a preliminary report following template provided by USAID | DELIVER PROJECT.

- Prepare and present findings of the assessment under the supervision of the country director.

- Respond to questions and/or requests for more information by the project’s country team and by HQ staff as needed during the course of this survey. Keep the local team and HQ informed of any changes in the timeline for delivery of products associated with this survey.

ESTIMATED TIME NEEDED FOR THIS CONSULTANCY: 30–40 days

DELIVERABLES:

- Field work logistics plan (to be submitted before data collection begins).
- Brief report on survey field work (to be submitted at the conclusion of data collection). This should include comments on any deviations from the planned sample or protocol.
- Preliminary draft survey report (to be submitted at the conclusion of the data analysis phase).
- Presentation of survey findings for local stakeholders.
Job Description for Data Collectors and Data Entry Personnel (LIAT)

Job Description
Field Data Collector

Health logistics project requires [number] short-term consultants as Field Data Collectors for a facility-based survey that will take place from [starting date] to [ending date]. We are looking for consultants who have the following qualifications:

- Experience in carrying out field surveys
- Willingness to commit to a three-week assignment, full time
- Willingness to work evenings and weekends during data collection
- Physical ability to travel in both urban and potentially difficult rural settings
- Familiarity with the areas to be visited: [List areas to be visited]
- Fluency in English
- Fluency in local languages a plus
- Familiarity with government health care system
- Detail-oriented
- Good communication skills
- Ability to work as a member of a team
- Degree in public health (desired)
- Quantitative research skills (desired)
- Knowledge of logistics systems (desired)

Data collection training will begin in [city name] on [starting date] and end on [ending date], including pilot testing of the survey tool and final revisions. The group of local consultants will include one to two more data collectors than will be needed for the actual survey. At the end of the training, trainers will select the final team of data collectors based on their demonstrated skills. In the event that any of the data collectors are unable to complete the field work, the remaining trainees may be asked to join the team during the data collection phase; however, these trainees will not receive per diem unless called to participate in the data collection.
Data collection will take place from [starting date] and end on [ending date]. Depending on the area to which the team will be traveling, data collectors may be required to travel the weekend prior to be ready for data collection at the facilities Monday morning, [date].
Job Description
Data Entry Staff

Health logistics project requires [number] short-term consultants as Data Entry Staff for facility-based survey that will take place from [starting date] to [ending date]. We are looking for consultants who have the following qualifications:

- Experience entering data into database
- Proficiency in Microsoft Access (data entry)
- Willingness to commit to a two-week assignment, full time
- Willingness to work evenings and weekends (as necessary)
- Fluency in English
- Fluency in local languages a plus
- Familiarity with government health care system
- Detail-oriented
- Good communication skills
- Ability to work as a member of a team
- Degree in public health (desired)
- Quantitative research skills (desired)
- Knowledge of logistics systems (desired)

Data collection training will begin in [city name] on [starting date] and end on [ending date], including pilot testing of the survey tool and final revisions. Data Entry Staff will participate in the data collection training and piloting of the survey instrument.

Data entry will take place from [starting date] and end on [ending date]. Consultants must be willing to enter large amounts of data in a short amount of time while maintaining a high level of data quality. Data entry may require work in the evening hours or on the weekends to complete data entry on schedule.
Appendix G

Materials Needed for Survey Training and Data Collection (LIAT)

MATERIALS CHECKLIST (LIAT)

Training Materials
1. Flip Chart
2. Flip Chart Easel
3. Marker (Multi-Colored)
4. Laptop Computer
5. LCD Projector
6. Power Strip/Extension Cord
7. All Sample Facility Forms Being Assessed
8. All Sample Products Being Assessed

Training Packets (one packet per participant; each packet should contain the following)
1. Copy of Participant Survey Manual
2. Copy of Survey Instrument
3. Copy of Facility Forms
4. Notebook
5. Pens (2 Blue)
6. Calculator
7. Clipboard
8. Name Badge

Data Collection Packets (per team to be provided to Team Leader)
1. Copy of Data Collection Schedule
2. Copy of Contact Phone Numbers
3. Copy of Call-In Schedule
4. Sufficient Copies of Tool for Each Facility to be Visited + Extras
5. Manila Envelopes (1 Per Survey + Extras)
6. Black Markers (2)
7. Copy of Facility List
8. Copies of Quality Control Checklist
LIAT Trainer’s Guide

LIAT TRAINER’S GUIDE

[Name of assessment]

Data Collectors Training & Field Test

[City, Country]

[Date]

TRAINING OBJECTIVES:
By the end of the training, participants will be able to:

- Describe the purpose and objectives of the assessment.
- Describe the instrument and how to collect data on logistics management of reproductive health commodities.
- Describe the team’s responsibilities in conducting the assessment.

TIME:
4 days, including site visit for field test of instrument

HANDOUTS:
- Survey Manual for Conducting the [name of assessment]
- [Name of tool]
- Other handouts for pilot testing and field data collection to be provided during the training.
DAY ONE

OPENING CEREMONIES

PRAYER (optional)
Many cultures like to open with a prayer or something similar. The prayer will depend on what is practiced in a particular country and can be from more than one religion/ethnic group/culture, etc. Encourage participants from different backgrounds to participate to reinforce the message that all are all working together and should respect one another.

SELF-INTRODUCTION OF PARTICIPANTS
Implement an interactive introduction exercise for participants or other self-introduction exercise. Participants will spend a lot of time together, it is recommended that an icebreaker be conducted to help the participants get to know one another. The following are examples:

- Divide the group in pairs, have each partner interview the other, and then have them all introduce their partners to the group.
- Develop a set of statements such as “likes to drink tea” and have participants go around the room asking people to sign their name next to a true statement about themselves.
- Have participants introduce themselves to the group, but have them include something unique or a “fun fact” about themselves.

WELCOME ADDRESS
A welcome address to participants

GOODWILL MESSAGE
Goodwill messages provided by representatives from partner organizations.

GOALS AND OBJECTIVES
Briefly explain the purpose of the assessment and the training.

The primary goal of the survey is to assess the Ministry of Health (MOH) logistics system, especially the availability and current stock of a selected list of public sector [type] commodities.

As part of their ongoing monitoring and evaluation, the MOH and its partners are conducting the survey for public sector facilities in logistics and commodity availability. The general objectives of the survey are as follows:

- Provide the MOH and [name of other program] with current information on logistics and stock status of key [type, i.e. FP, Malaria, HIV/AIDS] commodities.
- Provide the MOH [name of other program] and partners with information to measure improvements in the logistics system for malaria commodities through its support to MOH and [name of other program] activities.
Review the training objectives with participants:

- To describe the purpose and objectives of the assessment
- To describe the instrument and how to collect data on logistics management of key [type] commodities
- To describe the team’s responsibilities in conducting the assessment

TRAINING GROUND RULES

Agree on GROUP NORMS for the training with participants (solicit responses and post throughout training):

- Participants arrive to start on time.
- Participants stay the full time for all days of the training.
- Cell phones off during training sessions.
- Be respectful of the opinions of other participants.
- Other suggestions by participants

OVERVIEW OF THE [type] MANAGEMENT SYSTEM AND REVIEW OF SYSTEM FORMS

Provide a brief description of the [type] logistics management system to ensure that all participants are familiar with the system the survey will be assessing.

Provide a packet of relevant forms to each participant comprising the forms they will encounter at the facilities. Provide a brief description of what each form does, how it is used at the facilities, and what sections will be most relevant to data collection.

INTRODUCTION TO THE SURVEY AND INSTRUMENT

Explain that the survey instrument is based on the Logistics Indicator Assessment Tool (LIAT) that is designed to collect quantitative data on commodity logistics management from public sector facilities throughout the country. Explain that we will be reviewing the survey tool and changing it with participants’ suggestions and comments during the next four days. We will also conduct a field test of the instrument in nearby health facilities in [country].

During this training, participants will learn how to identify the appropriate person to interview at each facility and how to fill in the survey tool completely and correctly.

The schedule for the next [number] weeks (training and data collection) is challenging and will require everyone’s full commitment.

Answer any questions participants may have about the survey before continuing.

INTRODUCTION TO THE TRAINING

Review the training objectives with participants:

- Describe the purpose and objectives of the assessment.
- Describe the instrument and how to collect data on logistics management of [type] commodities.
- Describe the team’s responsibilities in conducting the assessment.
A total of [number] teams will conduct the survey. One person is assigned as the contact person/team leader for the team (to be referred to as the Team Leader). During the training workshop, participants will learn how to identify the appropriate respondents at each facility and how to fill in questionnaires correctly. Participants will also conduct a field test of the instrument with other trainees in nearby health facilities in [city/country].

**WHAT INFORMATION DOES THE INSTRUMENT COLLECT?**

This survey will collect data from various health facility levels. These data will focus on [type] commodity logistics system performance and product availability at the health facility. This will include asking questions of facility staff about forms and reports they use, product ordering, transportation, and supervision. It will also include a physical count of certain key [type] products each facility has in stock, recording stockouts that have occurred in the last six months, and making observations on storage area/warehouse conditions. *A list of logistics indicators is included in the Survey Manual provided to each participant for reference.*

The survey tool includes:

- Introduction statement and consent to continue
- Facility identification
- Interviewee information section
- Health commodity management sections (ordering and issuing, recordkeeping, reporting, management of cost recovery funds, monitoring and supervision, additional questions)
- Storage conditions table
- Availability of [type] product tables

Teams must follow a number of general procedures during a visit to a survey facility. These procedures are outlined in the following sections, along with instructions for recording responses in the survey tools and ensuring quality in the data collection process.

We will go over the selection, gaining permission, data collection, and organizing the data, and, finally, we will review the survey tool question by question.

**DATES AND TEAM MEMBER REQUIREMENTS**

Explain that the schedule for the next [time frame] is challenging and will require everyone’s full commitment.

Training and pilot testing will conclude on [date], and we will be preparing for site visits for data collection and requiring travel to arrive at the first district as soon as possible to be ready for work no later than [day of week] morning [date]. Travel requirements will vary depending on where each team will be going. Team Leaders will be responsible for data collection packets.

Travel arrangements have been made [insert other information as necessary]. Some teams will finish early. Please come straight back to [city, place] and review your questionnaires and debrief with the survey management team (*hand-over meetings with survey management team to be arranged*).

Mention that the administrative arrangements for the data collection period will be covered on [day of week].
SITE SELECTION

Explain that the facilities/stores selected in this survey were chosen to represent a national breakdown of facility types. Each facility selected met certain criteria to be included in the survey and be representative. This is important, because policy- and decisionmakers will be using the results of this survey for decisionmaking.

Therefore, it is important to try to collect the data from these particular representative sites.

If a health facility is unable to be visited (unable to locate it, permanently closed), call the Principal Investigator for a preselected replacement.

ORGANIZING DATA COLLECTION AT A FACILITY

At the start of the facility visit, the person in charge of the facility should help to ensure that the people the team will need to speak with are available. It is important to determine at the start of your visit whom you will need to interview and where medications and supplies are stored. Call and organize ahead of time if possible. For a small facility, this may be easier since most services might be in the same area. For larger facilities, this may involve different departments.

Experience has shown that a reasonable approach for organizing the data collection in facilities is as follows:

- Team members meet with the person in charge to explain survey components and gain permission for access to facility.
- Describe the data collection needs to identify the best approach for completing the work. You will need to interview staff who are responsible for ordering, managing, and recordkeeping for [type] product management. It is best to plan which staff will be interviewed so that the person in charge can ensure they remain available, or can contact them, if they have already left the facility.
- Reassure the in-charge that, other than a few of the specific management questions, he or she can delegate others at the facility to help the team. Often the person in charge feels obligated to try to respond to all questions and to show the team around the facility. This is not necessary and may create resentment in the in-charge who has many responsibilities.
- Ask to be introduced to all service areas where observations will occur.

People and areas in the facility for data collection are:

- In-charge on the day of the visit
- Pharmacy/store room: You will visit the pharmacy or storeroom where [type] commodities are stored and managed and will need to talk with the persons responsible for ordering and maintaining those commodities.

ENSURING QUALITY

All members of the team are responsible for ensuring that the data collected at each facility are as accurate and comprehensive as possible. Quality control is extremely important during a survey, especially a survey this large, and will be established at several levels, starting with data collection through data entry and cleaning and analysis.

Each data collector/interviewer is responsible for:
• Checking that questionnaires you have filled out are complete, ensuring that all answers are clear and reasonable, and that your handwriting is legible.
• If questions are omitted or there appear to be errors, you should return to the original respondent(s) if possible. Explain that you made an error, and ask the question again. Check all questionnaires received at the end of the day to ensure that all items are completed and skip patterns are followed.

Each team leader is responsible for:
• Ensuring that the interviewer doesn’t “guess,” orient, or answer the questions himself or herself.
• Ensuring that respect for interviewees is demonstrated at all times. It is easy for the interviewers to be so concerned by the process that they lose track of the purpose.
• Ensuring that the team finishes the appropriate number of completed instruments by the end of the data collection period.
• If a health facility is unable to be visited (unable to locate it, permanently closed), check with the Principal Investigator for a suitable replacement and note the change in the Sampling Log.
• Ensuring that the team arrives at the facility at an appropriate time. For example, for the first facility of the day, it would be helpful to be there before the clinic opens.
• Meeting with the person in charge to coordinate and explain the survey components and gain permission for access to the facility.
• Maintaining regular contact with the Survey Manager. Follow the call-in schedule that will be provided before you leave. Report on any problems with staff performance or aspects of the survey. Promptly notify the Survey Manager of any changes in the initial visit schedule.
• Ensuring that all team members meet at the end of each day’s data collection to review the questionnaires (using the Quality Control checklist) and check for accuracy and completeness.
• Discuss with team members any problems observed in the completed questionnaires or any problems experienced.
• Preparing and returning questionnaires as agreed upon.
• Submitting surveys as outlined by the survey submission guidelines.
• Review the Quality Control Checklist.

REVIEW OF PACKAGING/UNITS OF COUNT
Provide examples of each of the [type] commodities they will encounter in the facilities. Review with participants what the unit of count will be for each commodity. Discuss how they might find them packaged at facilities and reinforce the unit of count they must adhere to.

INSTRUMENT REVIEW
Go through the tool, read the questions one by one, and explain the nature or spirit of each question as well as why questions are asked in this order, etc.

Go “round robin,” reading each complete question and response option. After each, ask whether participants have any questions (language, meaning, links, etc.).

Are there any questions on these questions (language, meaning, links, etc.)?

Explain why each question is being asked and how the information will be used. Team members often need to paraphrase and/or translate and will need to understand the questions completely.
DAY TWO

INSTRUMENT REVIEW

Continue with the instrument review until instrument has been reviewed in its entirety.

Go through the tool, read the questions one by one, and explain the nature or spirit of each question as well as why questions are asked in this order, etc.

Go “round robin,” reading each complete question and response option. After each, ask whether participants have any questions (language, meaning, links, etc.).

Are there any questions on these questions (language, meaning, links, etc.)?

Explain why each question is being asked and how the information will be used. Team members often need to paraphrase and/or translate and will need to understand the questions completely.

INTERVIEW SKILLS AND ROLE-PLAY

Review with participants the interview process:

- Team members meet with the person in charge to explain survey components and gain permission for access to facility.
- Describe the data collection needs to identify the best approach for completing the work. You will need to interview staff who are responsible for ordering, managing, and recordkeeping for [type] product management. It is best to plan which staff will be interviewed so that the person in charge can ensure they remain available, or can contact them if they have already left the facility.
- Reassure the in-charge that, other than a few of the specific management questions, he or she can delegate others at the facility to help the team. Often the person in charge feels obligated to try to respond to all questions and to show the team around the facility. This is not necessary and may create resentment in the in-charge who has many responsibilities.
- Ask to be introduced to all service areas where observations will occur.

INTERVIEWING HINTS

Following is some general advice for conducting interviews or observations at a facility. Specific procedures for completing each survey are described in detail in each section.

Encourage respondents to cooperate by your approach.

The quality of the information you collect will depend to a large extent on the attitude of both the health providers and clients. Therefore, the interaction between you and all respondents is very important. All respondents should be treated respectfully and politely. The respondents should know that you appreciate their cooperation and the time they are taking to help make the survey successful.

If the respondents feel that the information is important and that you are sympathetic to their situation, they will be more straightforward with responses and will be more likely to answer
questions to the best of their ability. If they feel pressured to respond, or feel that the interview is a burden, they may not think about responses carefully.

Note: The introduction is important and will assist in releasing the in-charge and completing the interview with the pharmaceutical manager.

**Make sure you ask the questions as they are written in the survey tool.**

Speak slowly and clearly so that the people/person you are interviewing will have no difficulty in hearing or understanding the question. At times, you may need to repeat the question to be sure the respondent(s) understand(s) it. In those cases, do not paraphrase the question but repeat it as it is written. If, after you have repeated a question, the respondent(s) still do(es) not understand it, you may have to restate it. Be very careful when you change the wording, however, that you do not alter the meaning of the original question. As much as possible, wording that conveys the question so that respondents will understand should be discussed during training, and if appropriate, changes made in the survey tool at that time.

Note: Explain that this is why we go through the questions one by one. It is important that interviewers know and understand the “spirit” of each question and how the information will be used.

**Be straightforward.**

There are many questions in the survey that ask about the availability of items, and then ask to see them. Providers will be more cooperative if they know beforehand what to expect. If you ask questions, and then later ask to see items, people may think you are trying to trick them, or are “checking up” on their answer.

In order to have the greatest amount of cooperation, always tell the respondent what is coming. For example:

“Now I am going to ask you whether you have various types of equipment or supplies and whether they are in working order. After you answer all of them, I will need to see the items so that I can fill in this survey tool completely.”

**Never suggest answers to the respondents.**

If the respondents’ answers are not relevant to a question, do not prompt them by saying something like, “I suppose you mean that… Is that right?” In many cases, the informants will agree with your interpretation of their answer, even when that is not what they meant. Instead, in most cases, you should probe in such a manner that the informants themselves come up with the relevant answer, e.g., “Can you explain a little more?” “There is no hurry. Take a moment to think about it.”

Specific questions for which it may be necessary to provide additional clarification will be discussed in the detailed instructions for completing the survey tools. Even in these cases, you should provide only the minimum information required for an appropriate response. Except when specifically instructed (e.g., when asking the client about his or her thoughts on the facility during the client interview), never read the list of coded answers to the respondents, even if they have trouble answering the question. Keep in mind that you want an honest snapshot of what is happening in that facility.

Note: It is human nature for the interviewee to want to give the “right” answer. It is also human nature for the interviewer to want to make the person feel comfortable.
Ask all applicable questions.
In most cases, you will ask questions in the sequence in which they appear in the survey tool. However, because the organization of facilities often differs, you may find that to complete one module, you have to talk to more than one respondent or go to different areas of the facility. It is up to you to ensure that when you skip sections because the information must be collected from a different informant or location, you complete those sections before your departure.

Note: If you need to go back to questions with another respondent, it is helpful to develop a system that helps you quickly identify the questions. For example, circle the question, and before leaving the facility, do a quick review of the tool to ensure that each question has been answered.

Handle hesitant respondents tactfully.
There may be situations where the respondents simply say, “We don’t know,” give an irrelevant answer, act very bored or detached, contradict something they have already said, or refuse to answer the question. In these cases you must try to re-interest them in the conversation. For example, if you sense that they are growing restless, reassure them that there are not many more questions, and that the government is very interested in what they say about the services or their facility.

If the informants are giving irrelevant or elaborate answers (or complaining about something), do not stop them abruptly or rudely, but listen to what they have to say. Then try to steer them gently back to the original question. You can also write down what they say and tell them that it is duly noted. The interviewer must maintain a good atmosphere throughout the interview. The best atmosphere for an interview is one in which the respondents see the interviewer as a friendly, sympathetic, and responsive person who cares about them.

Minimize survey interference with the health workers’ ability to see patients.
If the health worker you need to see is busy with a client, wait until that visit is completed before approaching the health worker. Wait until there is a qualified person to show you around to complete the inventory and staff interview modules.

Offer no opinions or advice on specific facility practices during the actual interview.
If you are asked a question that you think requires your opinion or advice, simply respond that you are here to collect information to provide an overview of the stock availability, and you are interested in the systems and practices at this facility. Explaining this and then simply stating, “I’m not in a position to provide any advice or opinions,” may be sufficient.

If you observe what you consider to be wrong practices, make a note on the survey tool, but, again, make no comment or intervention until the end of the visit. At this time you can assist the facility by sharing your observations that you feel will improve its storage practices. Remember that the purpose of the survey is to collect information that will help to improve the health services overall.

Never raise expectations of immediate changes in the situation of the staff or facility.
Do not raise expectations that you can immediately help solve problems that the staff or clients raise. You are going to provide information to decisionmakers, health planners, and administrators, but any changes as a result of the survey will most likely occur over an extended period and be gradual in implementation. If clients or staff complain about the poor state of repair of the facility,
equipment, or supplies or other problems, provide a neutral or non-judgmental response (e.g., “I know these things are difficult”).

Optional: Conduct a role-play to practice introductions and interviewing.

**Role-Play Guidelines (optional, if time allows)**

This role-play will be used to demonstrate different scenarios you may encounter at the entry point for data collection and to discuss different ways to approach the facilities.

- Participants will break out into three groups, and each group will appoint two representatives: one as the interviewer and the second as the respondent.
- Facilitator will explain to members of each group their roles in the play.
- Representatives of the three groups will take turns in two minutes to act on the role-play while the rest of the participants comment on the different scenarios at the end of the exercise.
- The presentations will be discussed and analyzed based on the interviewing hints for clarity of communication.

**PREPARING FOR THE FIELD TEST**

Review with participants:

- Purpose of the field test
- Expectations of the assessment teams during the field test
- Assignment of team members to sites within the city and logistics (transport, times; etc.)
- Revisions of the instrument after the field test
- Administrative issues for the field test
DAY THREE

FIELD TESTING THE INSTRUMENT
Take note during the interviews about issues, questions, or problems. Even during the field testing, it is important to fill out the entire survey tool.

At the end of the field testing, all team members will reconvene in the conference room, discuss the major challenges in administering the tool, and start revisions as needed.

FIELD TEST DEBRIEFING AND INSTRUMENT REVISIONS
Debrief the field visit with participants and revise the tool section by section. Be sure to cover the following areas:

- Language
- Sources
- Addition of questions that are linked with objectives
- Personal behavior
DAY FOUR

FIELD TEST DEBRIEFING AND INSTRUMENT REVISIONS (if not finished on day three)
Continue to revise the tool section by section.
Be sure to cover the following areas:
• Language
• Sources
• Addition of questions that are linked with objectives
• Personal behavior

TEAM OVERVIEW AND MAPPING FOR DATA COLLECTION
Review the following details with participants:
• Assign sites to team members and review them with participants, answering any questions they may have
• Schedule field work
• Sampling Lists for each team
• Other materials
Allow teams time to meet together to map the site visit timeline/plan and complete envelope labeling.

DETAILS FOR DATA COLLECTION
Review with participants:
• In-country travel logistics
• Accommodation arrangements and per diem
• Call-in schedule
• Submission of instruments to central/courier service information
• Debriefing with collection teams individually
• Picking up data collection packets
• Answer any participants’ questions

TEAM LEADER AND MONITORS TRAINING
Using the survey manual and checklists, review with Team Leaders and Monitors their responsibilities. Review can be done simultaneously with each Trainer.
Appendix I

Illustrative Training Schedule (LIAT)
## Training Workshop Agenda

### [Name of Assessment]

### [Date]

### [City, Country]

<table>
<thead>
<tr>
<th>Time</th>
<th>Agenda Segment</th>
<th>Facilitator</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Day 1—[Date]</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8:00</td>
<td>Registration</td>
<td></td>
</tr>
<tr>
<td>8:30–8:35</td>
<td>Prayer</td>
<td></td>
</tr>
<tr>
<td>8:35–9:00</td>
<td>Self-Introduction of Participants</td>
<td></td>
</tr>
<tr>
<td>9:00–9:15</td>
<td>Opening Address</td>
<td></td>
</tr>
<tr>
<td>9:15–9:30</td>
<td>Goodwill Messages</td>
<td></td>
</tr>
<tr>
<td>9:30–10:00</td>
<td>Goals and Objectives &amp; Training Ground Rules</td>
<td></td>
</tr>
<tr>
<td>10:00–10:30</td>
<td><strong>Coffee/Tea Break</strong></td>
<td></td>
</tr>
<tr>
<td>10:30–11:15</td>
<td>Overview of the Logistics Management System and Review of System Forms</td>
<td></td>
</tr>
<tr>
<td>11:15–12:00</td>
<td>Introduction to the Survey and Instrument</td>
<td></td>
</tr>
<tr>
<td>12:00–12:30</td>
<td>Review of Packaging/Units of Count</td>
<td></td>
</tr>
<tr>
<td><strong>12:30–1:30</strong></td>
<td><strong>Lunch</strong></td>
<td></td>
</tr>
<tr>
<td>1:30–2:30</td>
<td>Instrument Review</td>
<td></td>
</tr>
<tr>
<td><strong>2:30–2:45</strong></td>
<td><strong>Coffee/Tea Break</strong></td>
<td></td>
</tr>
<tr>
<td>2:45–4:00</td>
<td>Instrument Review</td>
<td></td>
</tr>
<tr>
<td><strong>Day 2—[Date]</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8:30–8:45</td>
<td>Recap Day 1; Overview Day 2</td>
<td></td>
</tr>
<tr>
<td>8:45–9:45</td>
<td>Instrument Review (cont.)</td>
<td></td>
</tr>
<tr>
<td><strong>9:45–10:00</strong></td>
<td><strong>Coffee/Tea Break</strong></td>
<td></td>
</tr>
<tr>
<td>10:00–12:00</td>
<td>Instrument Review (cont.)</td>
<td></td>
</tr>
<tr>
<td><strong>12:00–1:00</strong></td>
<td><strong>Lunch</strong></td>
<td></td>
</tr>
<tr>
<td>1:00–2:00</td>
<td>Instrument Review (cont.)</td>
<td></td>
</tr>
<tr>
<td>2:00–2:45</td>
<td>Interview Skills and Role-Play</td>
<td></td>
</tr>
<tr>
<td><strong>2:45–3:00</strong></td>
<td><strong>Coffee/Tea Break</strong></td>
<td></td>
</tr>
<tr>
<td>3:00–3:45</td>
<td>Global Positioning System (GPS) Training</td>
<td></td>
</tr>
<tr>
<td>3:45–4:00</td>
<td>Preparation for Field Test</td>
<td></td>
</tr>
<tr>
<td><strong>Day 3</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>[Date]</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8:00–12:00</td>
<td>Field Testing</td>
<td></td>
</tr>
<tr>
<td><strong>12:30–1:30</strong></td>
<td><strong>Lunch</strong></td>
<td></td>
</tr>
<tr>
<td>1:30–2:30</td>
<td>Field Test Debriefing &amp; Instrument Revisions</td>
<td></td>
</tr>
<tr>
<td><strong>2:30–2:45</strong></td>
<td><strong>Coffee/Tea Break</strong></td>
<td></td>
</tr>
<tr>
<td>2:45–4:00</td>
<td>Instrument Revisions (cont.)</td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>Activity</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>8:30–9:00</td>
<td>Recap Day 3; Overview Day 4</td>
<td></td>
</tr>
<tr>
<td>9:00–10:00</td>
<td>Team Overview and Mapping for Data Collection</td>
<td></td>
</tr>
<tr>
<td><strong>10:00–10:30</strong></td>
<td><strong>Coffee/Tea Break</strong></td>
<td></td>
</tr>
<tr>
<td>10:30–11:30</td>
<td>Team Overview and Mapping for Data Collection (cont.)</td>
<td></td>
</tr>
<tr>
<td>11:30–12:30</td>
<td>Details for Data Collection</td>
<td></td>
</tr>
<tr>
<td><strong>12:30–1:30</strong></td>
<td><strong>Lunch</strong></td>
<td></td>
</tr>
<tr>
<td>1:30–2:30</td>
<td>Details for Data Collection</td>
<td></td>
</tr>
<tr>
<td>2:30–3:30</td>
<td>Team Leader and Monitor Training</td>
<td></td>
</tr>
<tr>
<td>3:30–4:00</td>
<td>Final Preparations and Departure of Participants*</td>
<td></td>
</tr>
</tbody>
</table>

* The Team Leaders will finalize the instrument, make copies of it, and prepare field packets for collection before the start of data collection.
Appendix J

LIAT Survey Manual
INTRODUCTION TO THE TRAINING

OVERVIEW
The purpose of this four-day training is to prepare participants for data collection in the field. By the end of the training, participants will be able to:

- Describe the purpose and objectives of the assessment.
- Describe the instrument and how to collect data on logistics management of contraceptive commodities.
- Describe the team’s responsibilities in conducting the assessment.

A total of [number of teams] data collection teams will conduct the survey. One person is assigned as the Team Leader, and each team is assigned a Survey Monitor. During the training workshop, you will learn how to identify the appropriate respondents at each facility and how to fill in questionnaires correctly. You will also conduct a field test of the instrument with other trainees in [city/region/state].
INTRODUCTION TO THE SURVEY

OVERVIEW
The primary goal of the survey is to assess the Ministry of Health (MOH) [type] products logistics system, especially the availability and current stock of a selected list of public sector [type] commodities.

The general objectives of the survey are as follows:

- Provide the MOH and partners with current information on logistics and stock status of key [type] commodities.
- Provide the MOH and partners with information to measure improvements in the logistics system for [type] commodities through support to MOH activities.

The survey instrument is based on the Logistics Indicator Assessment Tool (LIAT) that is designed to collect quantitative data on commodity logistics management from public sector facilities throughout the country.

We will be reviewing the survey tool and changing it with participants’ suggestions and comments during the next four days. We will also conduct a field test of the instrument in nearby health facilities in [city/region/state].

A total of [number] of teams will conduct the survey. During this training, participants will learn how to identify the appropriate person to interview at each facility and how to fill in the survey tool completely and correctly.

DATES AND TEAM MEMBER REQUIREMENTS
The schedule for the next [number] weeks is challenging and will require everyone’s full commitment.

Training and pilot testing will conclude on [date], and we will be preparing for site visits for data collection, requiring travel to arrive at the first district as soon as possible to be ready for work no later than [date]. Travel requirements will vary depending on where each team will be going. Travel for some teams may also be required on weekends following data collection to arrive at appropriate sites or to return to [location].

Travel arrangements have been made [insert other information as necessary]. Some teams will finish early. Please come straight back to [location] and review your questionnaires with a member of the survey management team (handover meetings with a member of the survey management team to be arranged).

SITE SELECTION
The facilities/warehouses selected in this survey met certain criteria to be included and are representative of a national breakdown of facility types. This is important, because policy- and decisionmakers will be using the results of this survey for decisionmaking.

Therefore, it is important to collect the data from these particular representative sites only.
If a health facility is unable to be visited (unable to locate it, permanently closed) only the Principal Investigator on the Survey Management Team can provide an appropriate replacement site and must be contacted.

**ORGANIZING DATA COLLECTION AT A FACILITY**

At the start of the facility visit, the person in charge of the facility should help to ensure that the people the team will need to speak with are available. It is important to determine at the start of your visit whom you will need to interview and where medications and supplies are stored. Contact appropriate people ahead of time to organize and facilitate this process if possible. For a small facility, this may be easier since most services might be in the same area. For larger facilities, this may involve different departments.

Experience has shown that a reasonable approach for organizing the data collection in facilities is as follows:

1. Team members meet with the person in charge to explain survey components and gain permission for access to facility.

2. Describe the data collection needs to identify the best approach for completing the work. You will need to interview staff who are responsible for ordering, managing, and recordkeeping for [type] product management. It is best to plan which staff will be interviewed so that the person in charge can ensure that they remain available, or can contact them if they have already left the facility.

3. Reassure the in-charge that, other than a few of the specific management questions, he or she can delegate others at the facility to help the team. Often the person in charge feels obligated to try to respond to all questions and to show the team around the facility. This is not necessary and may create resentment from the in-charge who has many responsibilities.

4. Ask to be introduced to all service areas where observations will occur.

People and areas in the facility for data collection are:

- In-charge on the day of the visit
- Pharmacy/storeroom: You will visit the pharmacy or storeroom where [type] commodities are stored and managed and will need to talk with the persons responsible for ordering and maintaining these commodities.

**ENSURING QUALITY**

All members of the team are responsible for ensuring that the data collected at each facility are as accurate and comprehensive as possible. Quality control is extremely important during a survey, especially a survey this large, and will be established at several levels, starting with data collection through data entry and cleaning and analysis.

Each data collector/interviewer is responsible for:

- Checking that questionnaires you have filled out are complete, ensuring that all answers are clear and reasonable and that your handwriting is legible.
• If questions are omitted or there appear to be errors, you should return to the original respondent(s) if possible. Explain that you made an error and ask the question again. Check all questionnaires received at the end of the day to ensure that all items are completed and skip patterns are followed.

Each team leader is responsible for:

• Ensuring that the team finishes the appropriate number of completed instruments by the end of the data collection period.

• If a health facility is unable to be visited (unable to locate it, permanently closed) check with the Principal Investigator on the Survey Management Team for a suitable replacement and note the change in the Team Sampling Log.

• Ensuring that the team arrives at the facility at an appropriate time. For example, for the first facility of the day, it would be helpful to be there before the clinic opens.

• Meeting with the person in charge to coordinate and explain the survey components and gain permission for access to the facility.

• Maintaining regular contact with the assigned monitor or survey managers. Follow the call-in schedule that will be provided before you leave. Feed back information on any problems with staff performance or aspects of the survey. Promptly notify the Survey Management Team of any changes in the visit schedule initially prepared.

• Ensuring that all team members meet at the end of each day's data collection to review the questionnaires (using the Quality Control checklist) and check for accuracy and completeness.

• Discussing with team members any problems observed in the completed questionnaires or any problems experienced.

• Preparing and returning questionnaires as agreed upon.
THE INSTRUMENT

OVERVIEW
This survey will collect data from various warehouse and facility levels. The data will focus on [type] commodity logistics system performance and product availability at the health facility. This will include asking questions of facility staff about forms and reports they use, product ordering, transportation, and supervision. It will also include a physical count of certain key [type] products the facility has in stock, recording stockouts that have occurred in the last six months, and making observations on storage area/warehouse conditions.

The survey tool includes:
1. Introduction statement and consent to continue
2. Facility and interviewee information section
3. Health commodity management sections (ordering and issuing, recordkeeping, reporting, management of cost recovery funds, monitoring and supervision, additional questions)
4. Storage conditions table
5. Availability and ordering tables

A list of logistics indicators is included at the end of the Survey Manual.
INTERVIEW SKILLS

INTERVIEWING HINTS
Following is some general advice for conducting interviews or observations at a facility.

**Encourage respondents to cooperate by your approach.**
The quality of the information you collect will depend to a large extent on the attitude of both the health providers and clients. Therefore, the interaction between you and all respondents is very important. All respondents should be treated respectfully and politely. The respondents should know that you appreciate their cooperation and the time they are taking to help make the survey successful.

If the respondents feel that the information is important and that you are sympathetic to their situation, they will be more straightforward with responses and will be more likely to answer questions to the best of their ability. If they feel pressured to respond, or feel that the interview is a burden, they may not think about responses carefully.

Note: The introduction is important and will assist in releasing the in-charge and completing the interview with the pharmaceutical manager.

**Make sure you ask the questions as they are written in the survey tool.**
Speak slowly and clearly so that the people/person you are interviewing will have no difficulty in hearing or understanding the question. At times, you may need to repeat the question to be sure the respondent(s) understand(s) it. In those cases, do not paraphrase the question but repeat it as it is written. If, after you have repeated a question, the respondent(s) still do(es) not understand it, you may have to restate it. Be very careful when you change the wording, however, that you do not alter the meaning of the original question. As much as possible, wording that conveys the question so that respondents will understand should be discussed during training, and if appropriate, changes made in the survey tool at that time.

Note: This is why we go through the questions one by one. It is important that you know and understand the “spirit” of each question and how the information will be used.

**Be straightforward.**
There are many questions in the survey that ask about the availability of items, and then ask to see them. Providers will be more cooperative if they know beforehand what to expect. If you ask questions and then later ask to see items, people may think you are trying to trick them, or are “checking up” on their answer.

In order to have the greatest amount of cooperation, always tell the respondent what is coming. For example:

“Now I am going to ask you whether you have various types of equipment or supplies and whether they are in working order. After you answer all of them, I will need to see the items so that I can fill in this survey tool completely.”

**Never suggest answers to the respondents.**
If the respondents’ answers are not relevant to a question, do not prompt them by saying something like, “I suppose you mean that…Is that right?” In many cases, the informants will agree with your interpretation of their answer, even when that is not what they meant. Instead, in most cases, you
should probe in such a manner that the informants themselves come up with the relevant answer, e.g.,
“Can you explain a little more?”
“There is no hurry. Take a moment to think about it.”

Specific questions for which it may be necessary to provide additional clarification will be discussed in
the detailed instructions for completing the survey tools. Even in these cases, you should provide only
the minimum information required for an appropriate response. Except when specifically instructed (e.g.,
when asking the client about his or her thoughts on the facility during the client interview), never read
the list of coded answers to the respondents, even if they have trouble in answering the question. Keep
in mind that you want an honest snapshot of what is happening in that facility.

Note: It is human nature for the interviewee to want to give the “right” answer. It is also human nature
for the interviewer to want to make the person feel comfortable.

Ask all applicable questions.
In most cases, you will ask questions in the sequence in which they appear in the survey tool. However,
because the organization of facilities often differs, you may find that to complete one module, you have
to talk to more than one respondent or go to different areas of the facility. It is up to you to ensure that
when you skip sections because the information must be collected from a different informant or
location, you complete those sections before your departure.

Note: If you need to go back to questions with another respondent, it is helpful to develop a system
that helps you quickly identify the questions. For example, circle the question, and before leaving the
facility do a quick review of the tool to ensure that each question has been answered.

Handle hesitant respondents tactfully
There may be situations where the respondents simply say, “We don’t know,” give an irrelevant answer,
act very bored or detached, contradict something they have already said, or refuse to answer the
question. In these cases you must try to re-interest them in the conversation. For example, if you sense
that they are growing restless, reassure them that there are not many more questions, and that the
government is very interested in what they say about the services or their facility.

If the informants are giving irrelevant or elaborate answers (or complaining about something), do not
stop them abruptly or rudely, but listen to what they have to say. Then try to steer them gently back to
the original question. You can also write down what they say and tell them that it is duly noted. The
interviewer must maintain a good atmosphere throughout the interview. The best atmosphere for an
interview is one in which the respondents see the interviewer as a friendly, sympathetic, and responsive
person who cares about them.

Minimize survey interference with the health workers’ ability to see patients.
If the health worker you need to see is busy with a client, wait until that visit is completed before
approaching the health worker. Wait until there is a qualified person to show you around to complete
the inventory and staff interview modules.

Offer no opinions or advice on specific facility practices during the actual interview.
If you are asked a question that you think requires your opinion or advice, simply respond that you are
here to collect information to provide an overview of the stock availability, and you are interested in the
systems and practices at this facility. Explaining this and then simply stating, “I’m not in a position to
provide any advice or opinions,” may be sufficient.
If you observe what you consider to be wrong practices, make a note on the survey tool, but, again, make no comment or intervention until the end of the visit. At this time you can assist the facility by sharing your observations that you feel will improve its storage practices. Remember that the purpose of the survey is to collect information that will help to improve the health services overall.

**Never raise expectations of immediate changes in the situation of the staff or facility.** Do not raise expectations that you can immediately help solve problems that the staff or clients raise. You are going to provide information to decisionmakers, health planners, and administrators, but any changes as a result of the survey will most likely occur over an extended period and be gradual in implementation. If clients or staff complain about the poor state of repair of the facility, equipment, or supplies or other problems, provide a neutral or non-judgmental response (e.g., “I know these things are difficult”).
LOGISTICS INDICATORS

Product Availability

1. Stock Status
   • Percent of facilities holding appropriate stock levels (i.e., between max-min stock levels) of a specific type of commodity at the time of the assessment
   • Percent of facilities holding more than appropriate maximum stock levels of a specific type of commodity at the time of assessment
   • Percent of facilities holding less than appropriate minimum stock levels of a specific type of commodity at the time of the assessment

2. Months of Stock on Hand
   • Months of stock of products on the day of the visit

3. Stockouts
   • Percent of facilities that were stocked out of a specific type of commodity at any point during the past six months
   • Average duration of stockout of a specific type of commodity during past six months
   • Percent of facilities stocked out of a specific type of commodity on the day of visit
   • Frequency of stockouts
   • Average number of stockouts by product

4. Expired Products
   • Percent of facilities with expired products on the day of the visit
   • Quantity of expired products on the day of the visit
   • Months of stocks of expired commodities on the day of the visit

Storage and Inventory Management

1. Inventory Control
   • Percent of facilities with updated stock cards for selected commodities
   • Percent of facilities that receive the quantity ordered
   • Percent of facilities with stock cards not matching physical counts for selected commodities

2. Storage and Quality Assurance
   • Percent of facilities meeting at least 80 percent of the acceptable storage conditions

3. Transportation and Distribution
   • Percent of facilities per type of transportation mostly used for commodity delivery
   • Percent of facilities per delivery type
Logistics Reporting and Ordering

1. Logistics Management Information Systems
   - Reported lead time
   - Accuracy of logistics data for inventory management
   - Percent of difference between quantity ordered and quantity received

Institutional Support

1. Logistics Training Needs
   - Percent of facilities whose staff did not receive training in completing logistics forms

2. Supervision
   - Percent of facilities that received supervision visit during specified period
   - Percent of facilities that received commodity management supervision during specified period

Order Fill Rates
   - Percent of facilities whose orders were completely filled
   - Percent of warehouses that filled complete orders
   - Percent of warehouses that filled a complete order by product
Appendix K

Checklists for Team Leaders and Monitors (LIAT)
**MONITORING QUALITY CONTROL CHECKLIST LOG**  
**[NAME OF ASSESSMENT]**  
**[COUNTRY, YEAR]**  

Name of Monitor: _________________________________________________  
State: _________________________________  

**Instructions to Monitor**: Select all instruments to check for quality according to the guidelines listed below. Record the unique identification number in the corresponding box on the **Unique Identification Number** line. When each item is complete and appropriate corrective actions have been taken as needed, place a tick (✓) in the corresponding box below the survey number.

<table>
<thead>
<tr>
<th>Unique Identification Number</th>
<th>CHECK WHEN COMPLETE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only BLUE ink has been used throughout the survey</td>
<td></td>
</tr>
<tr>
<td>All handwriting is legible</td>
<td></td>
</tr>
<tr>
<td>Skips were followed correctly throughout the survey</td>
<td></td>
</tr>
<tr>
<td>All questions are answered</td>
<td></td>
</tr>
<tr>
<td>Questions are not left blank appropriately</td>
<td></td>
</tr>
<tr>
<td>Units of count are recorded appropriately</td>
<td></td>
</tr>
<tr>
<td>Any errors have used the double line method</td>
<td></td>
</tr>
<tr>
<td>Tables are complete and filled out correctly (yes/no answered appropriately, dates recorded appropriately, numbers filled in correctly)</td>
<td></td>
</tr>
</tbody>
</table>
Checklist Guidance:

Any errors made during the survey that needed correction have been corrected appropriately and according to the training guidelines.

If you make a mistake entering an answer, or the respondents change their reply, put two horizontal lines through the incorrect response. Do not try to erase or write over an answer.

Example of corrected response

| 221 | What type of injection equipment is used during routine immunization sessions at this facility? | SINGLE USE ................................ 1 |
|     |                                                                                               | STERILIZABLE ................................ 2 |
|     |                                                                                               | OTHER injection gun ..................... 6 | (SPECIFY)

Remember that if there are two responses for a particular question that requires only one response, it may be impossible when the data are being computerized later to determine the correct answer. If you write over an answer, the data entry staff frequently cannot determine which of the two responses you meant as the correct response.

Skips were followed correctly throughout the survey.

The questionnaire is set up to avoid as much redundancy as possible and ask only appropriate questions given a situation. Arrows are used throughout the questionnaires to give directions about the next question to ask (i.e., “to skip to”). It is very important to follow these skips, for they will increase the cooperation of the respondents. Skips enable the interviewer to collect the necessary information in as efficient a manner as possible.

Example of response indicating a “skip”:

| 204 | If LMIS forms are used, are reports sent to the higher level? | YES........................................1 |
|     |                                                                 | NO.......................................2 |
|     |                                                                 | NOT APPLICABLE.........................3 |
|     |                                                                 | DON’T KNOW ..........................8 | ➤ 207

Tables are complete and filled out correctly (i.e., yes/no questions are answered appropriately; numbers are recorded appropriately).

In the table, if the questions asks for a “yes” or a “no” response, the response should indicate either “yes” or “no.” Similarly, if the table requires numbers, ensure that the response is in numbers.

The survey has been filled out legibly and with legible handwriting.

You should be able to clearly see which response may have been circled and read all names, written responses, and numbers. All written items should be printed. If an item is not legible, ask the data collector for clarification.

The units of count are recorded appropriately.
This is particularly important in the table. During the training, how the “units of count” are to be recorded has been specified. Ensure that each survey follows the same method of recording “units of count,” as defined during the training.
Appendix L

Standard Analysis Guidelines for LIAT
STANDARD ANALYSIS GUIDELINES
FOR LOGISTICS INDICATOR ASSESSMENT TOOL (LIAT)

Note:
- All indicators should be calculated for each product.
- Assumes standard practice that NO = 0 and YES = 1.
- Current steps assume crosstabs is needed to separate results by separate facilities. If facilities are grouped as one, frequencies can be run.

<table>
<thead>
<tr>
<th>Indicator 1: Percentage of facilities that offer (X type of) services</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question to answer</td>
</tr>
<tr>
<td>What does it measure?</td>
</tr>
<tr>
<td>This indicator measures the total percentage of facilities in the sample that offer the specific type of service in question. Subsequent indicators are filtered by those facilities that answer “YES” to this variable.</td>
</tr>
<tr>
<td>How do you get it?</td>
</tr>
<tr>
<td>Step 1:</td>
</tr>
<tr>
<td>To determine the percent of facilities that offer a particular type of service by facility type, run a crosstabs between the facility type variable and the offer services variable:</td>
</tr>
<tr>
<td>Analyze ➔ Descriptive Statistics ➔ Crosstabs ➔ (facility type variable) by (offer services variable)</td>
</tr>
<tr>
<td>Click the CELLS button ➔ Make sure the following are checked:</td>
</tr>
<tr>
<td>Counts ➔ Observed</td>
</tr>
<tr>
<td>Percentages ➔ Row</td>
</tr>
<tr>
<td>Noninteger Weights ➔ Round Cell Count</td>
</tr>
<tr>
<td>Sample Syntax</td>
</tr>
<tr>
<td>CROSSTABS</td>
</tr>
<tr>
<td>/TABLES = facility type variable BY offer services variable</td>
</tr>
<tr>
<td>/FORMAT = AVALUE TABLES</td>
</tr>
<tr>
<td>/CELLS = COUNT ROW</td>
</tr>
<tr>
<td>/COUNT ROUND CELL.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Indicator 2: Percentage of facilities with available stock cards by product</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question to answer</td>
</tr>
<tr>
<td>What does it measure?</td>
</tr>
<tr>
<td>This indicator measures the percentage of facilities that have stock cards available for each product.</td>
</tr>
<tr>
<td>How do you get it?</td>
</tr>
<tr>
<td>NOTE: Variables for this indicator are usually pulled from the Stock Status Table.</td>
</tr>
<tr>
<td>Step 1:</td>
</tr>
<tr>
<td>Filter for those facilities that manage product X at this facility.</td>
</tr>
<tr>
<td>Data ➔ Select Cases ➔ If condition is satisfied… ➔ IF ➔ (manage product at</td>
</tr>
</tbody>
</table>
**Indicator 3: Percentage of facilities with updated stock cards by product**

**Question to answer**
What percent of facilities have updated stock cards for each product managed at this facility?

**What does it measure?**
This indicator measures the percentage of facilities with updated stock cards (within the last 30 days prior to the date of the visit).

**How do you get it?**

*NOTE*: Variables for this indicator are usually pulled from the Stock Status Table.

**Step 1:**
Filter for those facilities that have stock card available for product X.

*Data ➔ Select Cases ➔ If condition is satisfied… ➔ IF ➔ (stock card available variable) = 1 ➔ CONTINUE ➔ OK*

*In the output box, select “filter out unselected cases”*

**Step 2:**
Run a crosstabs between (facility type variable) and (stock card available variable)

*Analyze ➔ Descriptive Statistics ➔ Crosstabs ➔ (facility type variable) by (stock card available variable)*

*Click the CELLS button ➔ Make sure the following are checked:*

- Counts ➔ Observed
- Percentages ➔ Row
- Noninteger Weights ➔ Round Cell Count

**Sample Syntax**

USE ALL.
COMPUTE filter_$ = (manage product at this facility variable = 1).
VARIABLE LABEL filter_$ 'manage product at this facility variable = 1 (FILTER).'
VALUE LABELS filter_$ 0 'Not Selected' 1 'Selected.'
FORMAT filter_$ (f1.0).
FILTER BY filter_$.
EXECUTE.

CROSSTABS
/ TABLES = facility type variable BY stock card available variable
/FORMAT = AVVALUE TABLES
/CELLS = COUNT ROW
/COUNT ROUND CELL.
Run crosstabs function between (facility type variable) and (stock card updated variable)

*Analyze ➔ Descriptive Statistics ➔ Crosstabs ➔ (facility type variable) by (stock card updated variable)*

### Sample Syntax

```plaintext
USE ALL.
COMPUTE filter_\$ = (stock card available variable = 1).
VARIABLE LABEL filter_\$ 'stock card available variable = 1 (FILTER).'</n
VALUE LABELS filter_\$ 0 'Not Selected' 1 'Selected.'
FORMAT filter_\$ (f1.0).
FILTER BY filter_\$. EXECUTE .
CROSSTABS
/TABLES = facility type variable BY stock card updated variable
/FORMAT = AVVALUE TABLES
/CELLS = COUNT ROW
/COUNT ROUND CELL.
```

### Indicator 4: Percentage of facilities stocked out of product X within the last six months

<table>
<thead>
<tr>
<th>Question to answer</th>
<th>What percent of facilities were stocked out of a particular product in the last six months prior to the assessment?</th>
</tr>
</thead>
<tbody>
<tr>
<td>What does it measure?</td>
<td>This indicator measures the percentage of facilities that experienced a stockout of product “X” during the six months prior to the assessment. As it measures product availability over a period of time, it is a proxy indicator for commodity availability at facilities for specific products.</td>
</tr>
</tbody>
</table>
| How do you get it? | **NOTE:** Variables for this indicator are usually pulled from the Stock Status Table.

**Step 1:**
Filter for those facilities that manage this product at the facility.

*Data ➔ Select Cases ➔ If condition is satisfied… ➔ IF ➔ (manage product at this facility variable) = 1 ➔ CONTINUE ➔ OK*

*In the output box, select “filter out unselected cases.”*

**Step 2:**
Run a crosstabs between (facility type variable) and (stockout in most recent six months variable).

*Analyze ➔ Descriptive Statistics ➔ Crosstabs ➔ (facility type variable) by (stockout in most recent six months variable)*

### Sample Syntax

```plaintext
USE ALL.
COMPUTE filter_\$ = (manage product at this facility variable = 1).
```
### Variable Label

```
VARIABLE LABEL filter_$ 'manage product at this facility variable = 1 (FILTER).'
VALUE LABELS filter_$ 0 'Not Selected' 1 'Selected.'
FORMAT filter_$ (f1.0).
FILTER BY filter_$.
EXECUTE .
```

```crosstabs
CROSSTABS
/TABLES = facility type variable BY stockout in most recent six months variable
/FORMAT = AVALUE TABLES
/CELLS = COUNT ROW
/COUNT ROUND CELL.
```

### Indicator 5: Average frequency of stockouts of a product in the previous six months

<table>
<thead>
<tr>
<th>Question to answer</th>
<th>What is the average number of stockouts a facility experiences for product x in the last six months?</th>
</tr>
</thead>
<tbody>
<tr>
<td>What does it measure?</td>
<td>This indicator measures an average for the total number times (how frequently) a facility is stocked out of product X during the six month period prior to the assessment. This is calculated by taking the average of the total number of stockouts for each product in question.</td>
</tr>
</tbody>
</table>
| How do you get it? | **Step 1:**

Filter for those facilities by manage the product at the facility and experienced a stockout of product most recent six months variables.

*Data → Select Cases → If condition is satisfied… → IF → (manage product at this facility variable) & (stockout of product most recent six months variable) = 1 → CONTINUE → OK*

*In the output box, select “filter out unselected cases.”*

**Step 2:**

Split file by facility type variable.

*Data → Split File → (click “compare groups”) → move facility type variable into box → select “file is already sorted”*

**Step 3:**

Determine the mean.

*Analyze → Descriptive Statistics → Descriptives → move “no. of stockouts” variable into variable box → Click OPTIONS → Select mean, standard deviation, minimum, maximum, and variable list*

**Step 4:**

Remember to run a SPLIT FILE OFF when completed.

### Sample Syntax

```
USE ALL.
COMPUTE filter_$ = (product managed at this facility variable & stockout most
```
**Indicator 6: Average number of days a product was stocked out in the previous six months**

<table>
<thead>
<tr>
<th>Question to answer</th>
<th>How many days, on average, was a facility stocked out of product X during the previous six months?</th>
</tr>
</thead>
<tbody>
<tr>
<td>What does it measure?</td>
<td>This indicator measures on average the number of days facilities did not have product X during the previous six months by level.</td>
</tr>
<tr>
<td>How do you get it?</td>
<td>Step 1: Filter for those facilities that manage product X.</td>
</tr>
<tr>
<td></td>
<td>Data → Select Cases → If condition is satisfied… → IF → (manage product at this facility variable) = 1 → CONTINUE → OK</td>
</tr>
<tr>
<td></td>
<td>In the output box, select “filter out unselected cases.”</td>
</tr>
<tr>
<td></td>
<td>Step 2: Split file by facility type.</td>
</tr>
<tr>
<td></td>
<td>Data → Split File → (click “compare groups”) → move facility type variable into box → select “file is already sorted”</td>
</tr>
<tr>
<td></td>
<td>Step 3: Run a descriptives function.</td>
</tr>
<tr>
<td></td>
<td>Analyze → Descriptive Statistics → Descriptives → move total no. of days stocked out variable into box → Click OPTIONS → Select mean, standard deviation, minimum, maximum, variable list</td>
</tr>
<tr>
<td></td>
<td>Make sure to run SPLIT FILE OFF when completed.</td>
</tr>
</tbody>
</table>

**Sample Syntax**

```
USE ALL.
```
COMPUTE filter__$ = (manage product at this facility variable = 1).
VARIABLE LABEL filter__$ 'manage product at this facility variable = 1 (FILTER).'
VALUE LABELS filter__$ 0 'Not Selected' 1 'Selected.'
FORMAT filter__$ (f1.0).
FILTER BY filter__$.
EXECUTE .

SPLIT FILE
    LAYERED BY facility type variable .

DESCRIPTIVES
    VARIABLES = total number of days stocked out variable /
    STATISTICS = MEAN STDDEV MIN MAX.

SPLIT FILE OFF.

---

**Indicator 7: Average duration in days of stockouts during the previous six months**

<table>
<thead>
<tr>
<th>Question to answer</th>
<th>On average, how long did each stockout last?</th>
</tr>
</thead>
<tbody>
<tr>
<td>What does it measure?</td>
<td></td>
</tr>
<tr>
<td>How do you get it?</td>
<td></td>
</tr>
</tbody>
</table>

**Step 1:**
Filter for those facilities that manage product X.

Data  Select Cases  If condition is satisfied…  IF  (manage product at this facility variable)=1  CONTINUE  OK

In the output box, select “filter out unselected cases”

**Step 2:**
Create a new variable that is divides total no. of days stocked out variable by number of stockouts variable.

Transform  Compute  under “target variable,” provide a new name for the variable "Variable A"  under “numeric expression,” create the equation “total no. of days stocked out variable"/ “number of stockouts variable”

**Step 3:**
Split file by facility type.

Data  Split File  (click “compare groups”)  move facility type variable into box  select “file is already sorted”

**Step 4:**
Run a descriptives function on new variable created.

Analyze  Descriptive Statistics  Descriptives  move Variable A into box  Click OPTIONS  Select mean, standard deviation, minimum, maximum, variable list
**Sample Syntax**

```
USE ALL.
COMPUTE filter_\$ = (manage product at this facility variable = 1).
VARIABLE LABEL filter_\$ 'manage product at this facility variable = 1 (FILTER).'</n
```

```
VALUE LABELS filter_\$ 0 'Not Selected' 1 'Selected.'
FORMAT filter_\$ (f1.0).
FILTER BY filter_\$.
EXECUTE.
```

```
COMPUTE VARIABLE A = total no. of days stocked out variable / number of stockouts variable.
EXECUTE.
```

```
SPLIT FILE LAYERED BY facility type variable.
```

```
DESCRIPTIVES
VARIABLES = total number of days stocked out variable /STATISTICS = MEAN STDDEV MIN MAX.
```

```
SPLIT FILE OFF.
```

---

### Indicator 8: Percentage of facilities stocked out on the day of the visit

**Question to answer**

What percent of facilities are stocked out of product X on the day of the visit?

**What does it measure?**

This is one of the key indicators to measure product availability on the day of the visit. This indicator is also not dependent on the presence of a stock card at the facility. It is calculated based on the presence of stock inventory on the day of the visit.

**How do you get it?**

**Step 1:**

Filter for those facilities that manage product X.

*Data → Select Cases → If condition is satisfied… → IF → (manage product at this facility variable) = 1 → CONTINUE → OK*

In the output box, select “filter out unselected cases.”

**Step 2:**

Run a crosstabs between (facility type variable) and (stockout today).

*Analyze → Descriptive Statistics → Crosstabs → (facility type variable) by (stockout today variable)*

**Sample Syntax**

```
USE ALL.
```
COMPUTE filter$_$ = ( manage product at this facility variable = 1).
VARIABLE LABEL filter$_$ 'manage product at this facility variable = 1 (FILTER).'</nVALUE LABELS filter$_$ 0 'Not Selected' 1 'Selected.'
FORMAT filter$_$ (f1.0).
FILTER BY filter$_$.
EXECUTE.

CROSSTABS
/TABLES = facility type variable BY stockout today variable
/FORMAT = AVALUE TABLES
/CELLS = COUNT ROW
/COUNT ROUND CELL.

Indicator 9: Percent discrepancy between physical inventory and stock card balance

Question to answer
What is the percent discrepancy (no discrepancy, or +/- 10% discrepancy) between the physical inventory and stock card balance for product X at each facility level?

What does it measure?
This indicator measures the accuracy in recordkeeping of logistics data. Physical inventory is conducted to determine the actual physical count of product available on the day of the visit. Lowest possible unit of measure is used for conducting physical inventory. Depending on program goals this can be calculated within +/- 10%.

How do you get it?
Step 1:
Filter for those facilities that manage the product at the facility.

Data ➔ Select Cases ➔ If condition is satisfied… ➔ IF ➔ (manage product at this facility) = 1 ➔ CONTINUE ➔ OK

In the output box, select “filter out unselected cases.”

Step 2:
Create a new variable that is the difference between the last balance on stockcard and the physical inventory of store.

Transform ➔ Compute ➔ under “target variable,” provide a new name for the variable “Variable A” ➔ under “numeric expression”, create the equation “last balance on stock card variable” – “physical inventory of store variable”

Step 3:
Recode “Variable A” into a second variable to determine those with accurate stock card balances (i.e., no difference between the last balance on the stock card and the physical inventory, or 0 difference).

Transform ➔ Recode ➔ Into Different Variable ➔ Input variable (Variable A) ➔ provide Output Variable name (Variable B) and Label (Facilities with accurate stock card balances) ➔ Click “Old and New Values” and input the following:
### Old Values | New Values
---|---
0 (value) | 0 (value)
Lowest thru -1 (range) | 1 (value)
1 thru Highest (range) | 1 (value)

**Step 4:**
Run a crosstabs between `facility type variable` and `Variable B`.

*Analyze ➔ Descriptive Statistics ➔ Crosstabs ➔ (facility type variable) by (Variable B)*

**Step 5:**
Create a new variable that will calculate the percentage difference between last balance on stockcard and the physical inventory of store.

*Transform ➔ Compute ➔ under “target variable,” provide a new name for the variable “Variable C” and label (percent difference between stockcard and physical inventory) ➔ under “numeric expression,” create the equation: (last balance on stock card variable – physical inventory of store variable)/(physical inventory of store variable + .1)*

**Step 6:**
Filter for those facilities that manage the product at the facility.

*Data ➔ Select Cases ➔ If condition is satisfied… ➔ IF ➔ (manage product at this facility) = 1 ➔ CONTINUE ➔ OK*

*In the output box, select “filter out unselected cases.”*

**Step 7:**
Recode Variable C to determine percentage that fall within a + or – 10% category.

*Transform ➔ Recode ➔ Into Different Variable ➔ Input variable (Variable C) ➔ provide Output Variable name (Variable D) and Label (Near accurate balance of product X) ➔ Click “Old and New Values” and input the following:

<table>
<thead>
<tr>
<th>Old Values</th>
<th>New Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>MISSING</td>
<td>SYSMIS</td>
</tr>
<tr>
<td>-10 thru 10 (range)</td>
<td>1 (value)</td>
</tr>
<tr>
<td>ELSE</td>
<td>0 (value)</td>
</tr>
</tbody>
</table>

**Step 8:**
Run a crosstabs between `facility type variable` and `Variable D`.

*Analyze ➔ Descriptive Statistics ➔ Crosstabs ➔ (facility type variable) by (Variable D)*

**Sample Syntax**
```
USE ALL.
COMPUTE filter_$ = (manage product at this facility = 1).
VARIABLE LABEL filter_$ ‘manage product at this facility = 1 (FILTER).’
```
VALUE LABELS filter_$ 0 ‘Not Selected’ 1 ‘Selected.’
FORMAT filter_$ (f1.0).
FILTER BY filter_$.
EXECUTE.

COMPUTE VARIABLE A = last balance on stockcard – physical inventory of store.
EXECUTE.

RECODE
  VARIABLE A
    (0 = 0) (Lowest thru -1 = 1) (1 thru Highest = 1) INTO VARIABLE B.
VARIABLE LABELS VARIABLE B ‘Facilities with accurate stockcard balance.’
EXECUTE.

CROSSTABS
  /TABLES = facility type variable BY VARIABLE B
  /FORMAT = AVVALUE TABLES
  /CELLS = COUNT ROW
  /COUNT ROUND CELL.

COMPUTE VARIABLE C = 100* (last balance on stockcard - physical inventory of store)/(physical inventory of store + .1).
VARIABLE LABELS VARIABLE C ‘Percent difference between stockcard and physical’+ 
  ‘inventory.’
EXECUTE.

USE ALL.
COMPUTE filter_$ = (manage product at this facility = 1).
VARIABLE LABEL filter_$ ‘manage product at this facility = 1 (FILTER).’
VALUE LABELS filter_$ 0 ‘Not Selected’ 1 ‘Selected.’
FORMAT filter_$ (f1.0).
FILTER BY filter_$.
EXECUTE.

RECODE
  VARIABLE C
    (MISSING = SYSMIS) (-10 thru 10 = 1) (ELSE = 0) INTO VARIABLE D.
VARIABLE LABELS VARIABLE D ‘Near accurate balance of product.’
EXECUTE.

CROSSTABS
  /TABLES = facility type variable BY VARIABLE D
  /FORMAT = AVVALUE TABLES
  /CELLS = COUNT ROW
  /COUNT ROUND CELL.
### Indicator 10: Months of stock on hand

<table>
<thead>
<tr>
<th>Question to answer</th>
<th>How many months of stock on hand of product X is available at each facility level?</th>
</tr>
</thead>
<tbody>
<tr>
<td>What does it measure?</td>
<td>This indicator measures average months of stock available at the facility on the day of the visit. This indicator helps determine whether the facility is adequately stocked to meet the needs of its clients.</td>
</tr>
</tbody>
</table>
| How do you get it? | **Step 1:** Filter by if managed at this facility variable.  

Data ➔ Select Cases ➔ If condition is satisfied… ➔ IF ➔ (managed at this facility variable)=1 ➔ CONTINUE ➔ OK  

In the output box, select “filter out unselected cases.”  

**Step 2:** Create a new variable (Variable A) that is the difference between (number of months of data available variable * 30 days) – (total number of days stocked out variable).  

Transform ➔ Compute ➔ under “target variable,” provide a new name for the variable “Variable A” ➔ under “numeric expression,” create the equation (“no. of months of data available variable” * 30) – “total no. of days stocked out variable.”  

**Step 3:** Create a new variable (Variable B) that divides the variable created in Step 2 (Variable A) by 30. The new variable is the number of months where stock is available.  

Transform ➔ Compute ➔ under “target variable,” provide a new name for the variable “Variable B” ➔ under “numeric expression,” create the equation “Variable A”/ 30).  

**Step 4:** Create a new variable (Variable C) that is the physical inventory variable divided by (total dispensed most recent six months variable divided by Variable B).  

Transform ➔ Compute ➔ under “target variable,” provide a new name for the variable “Variable C” ➔ under “numeric expression,” create the equation physical inventory variable/(total dispensed most recent 6 months variable/Variable B).  

**Step 5:** Split the file by facility type variable.  

Data ➔ Split File ➔ (click “compare groups”) ➔ move facility type variable into box  

**Step 6:**
Run a descriptives function of Variable C.

*Analyze ➔ Descriptive Statistics ➔ move Variable C into box ➔ Click OPTIONS ➔ Select mean, standard deviation, min, max, variable list*

Make sure to run SPLIT FILE OFF when completed.

**Sample Syntax**

```plaintext
USE ALL.
COMPUTE filter_\$ = ( managed at this facility variable = 1).
VARIABLE LABEL filter_\$ 'managed at this facility variable = 1 (FILTER).'
VALUE LABELS filter_\$ 0 'Not Selected' 1 'Selected.'
FORMAT filter_\$ (f1.0).
FILTER BY filter_\$.
EXECUTE.

COMPUTE Variable A = (no. of months of data available variable * 30) - total no. of days stocked out variable.
EXECUTE.

COMPUTE Variable B = Variable A / 30.
EXECUTE.

COMPUTE Variable C = physical inventory of store variable/(total dispensed most recent 6 months variable/Variable B).
EXECUTE.

SPLIT FILE.
   LAYERED BY facility type variable .

DESCRIPTIVES
   VARIABLES = Variable C
   /STATISTICS =MEAN STDDEV MIN MAX.

SPLIT FILE
   OFF.
```

**Indicator 11: Percent of facilities that maintain acceptable storage conditions**

<table>
<thead>
<tr>
<th><strong>Question to answer</strong></th>
<th>What percent of facilities falls within the unacceptable, acceptable, and excellent ranges for storage conditions?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>What does it measure?</strong></td>
<td>This indicator measures the percentage of facilities that meet acceptable storage conditions required to protect the integrity of products. This indicator is applied to measure unacceptable (0–10 conditions met); acceptable (11–13 conditions met); and excellent 13–14 conditions met.</td>
</tr>
<tr>
<td><strong>How do you get it?</strong></td>
<td><strong>Step 1:</strong> Filter by if facility offers services variable.</td>
</tr>
</tbody>
</table>
Data → Select Cases → If condition is satisfied… → IF (offer services variable)=1 → CONTINUE → OK

In the output box, select “filter out unselected cases.”

**Step 2:**
Create a new variable that adds the individual storage conditions together (SC1, SC2, SC3, etc.).

Transform → Compute → Type in a new Target Variable name (Variable A) → In the Numeric Expression Box, add the storage conditions (SC1 + SC2 + SC3 + etc.) → Click OK

**Step 3:**
Create a new variable (Variable B) from that created in Step 2 (Variable A).

Transform → Recode → Into Different Variable → Move Variable A into Numeric Variables box → Provide an Output Variable name and label (Variable B) → Click Change → Click Old and New Values →

<table>
<thead>
<tr>
<th>Old Value</th>
<th>New Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 thru 10 (range)</td>
<td>1 (unacceptable)</td>
</tr>
<tr>
<td>11 thru 13 (range)</td>
<td>2 (acceptable)</td>
</tr>
<tr>
<td>13.01 thru 14 (range)</td>
<td>3 (excellent)</td>
</tr>
</tbody>
</table>

Click Continue → Click OK

**Step 4:**
Run a crosstabs between facility type variable and Variable B.

Analyze → Descriptive Statistics → Crosstabs → (facility type variable) by (Variable B)

**Sample Syntax**

USE ALL.
COMPUTE filter_$ = (offer services variable = 1).
VARIABLE LABEL filter_$ ‘offer services variable = 1 (FILTER).’
VALUE LABELS filter_$ 0 ‘Not Selected’ 1 ‘Selected.’
FORMAT filter_$ (f1.0).
FILTER BY filter_$.
EXECUTE.

EXECUTE.

RECODE
Variable A
  (0 thru 10 = 1) (11 thru 13 = 2) (13.01 thru 14 = 3) INTO Variable B.
VARIABLE LABELS Variable B ‘Variable B label.’
## Indicator 12: Percent of facilities that meeting individual storage conditions

<table>
<thead>
<tr>
<th>Question to answer</th>
<th>What percent of facilities meets each of the individual storage conditions?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>What does it measure?</strong></td>
<td>This indicator measures the percentage of facilities that meet individual storage conditions required to protect the integrity of products.</td>
</tr>
<tr>
<td><strong>How do you get it?</strong></td>
<td><strong>Step 1:</strong> Filter by the facility offers services variable.</td>
</tr>
</tbody>
</table>

Data → Select Cases → If condition is satisfied… → IF → (offer services variable) = 1 → CONTINUE → OK

*In the output box, select “filter out unselected cases.”*

**Step 7:** Run a crosstabs between facility type variable and each of the individual storage conditions.

*Analyze → Descriptive Statistics → Crosstabs → (facility type variable) by (SC1
SC2 SC3 SC4 SC5 SC6 SC7 SC8 SC9 SC10 SC11 SC12 SC13 SC14)*

<table>
<thead>
<tr>
<th>Sample Syntax</th>
<th>USE ALL.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>COMPUTE filter_$ = (offer services variable = 1).</td>
</tr>
<tr>
<td></td>
<td>VARIABLE LABEL filter_$ ‘offer services variable = 1 (FILTER).’</td>
</tr>
<tr>
<td></td>
<td>VALUE LABELS filter_$ 0 ‘Not Selected’ 1 ‘Selected.’</td>
</tr>
<tr>
<td></td>
<td>FORMAT filter_$ (f1.0).</td>
</tr>
</tbody>
</table>
|               | FILTER BY filter_$.
<p>|               | EXECUTE. |
|               | CROSSTABS |
|               | /TABLES = facility type variable BY SC1 SC2 SC3 SC4 SC5 SC6 SC7 SC8 SC9 SC10 SC11 SC12 SC13 SC14 |
|               | /FORMAT = AVALUE TABLES |
|               | /CELLS = COUNT ROW |
|               | /COUNT ROUND CELL. |</p>
<table>
<thead>
<tr>
<th><strong>Indicator 13: Percent of facilities stocked between minimum and maximum inventory levels</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Question to answer</strong></td>
</tr>
<tr>
<td><strong>What does it measure?</strong></td>
</tr>
</tbody>
</table>
| **How do you get it?** | **Step 1:** Filter by if facility offers services variable.  
*Data → Select Cases → If condition is satisfied… → IF (offer services variable)=1 → CONTINUE → OK*  
*In the output box, select “filter out unselected cases.”*  
**Step 2:** Use the final variable created in Indicator 9 (Steps 2–4) for remaining steps.  
*Reflected to as Variable X*  
**Step 3:** Recode Variable X into a new variable with new values based on minimum and maximum levels (assuming 1 month minimum, 1–2 months as between max-min levels, and greater than 2 months as maximum).  
*Transform → Recode → Into Different Variable → Transfer Variable X into box and fill in “Output Variable” with new name (Variable Y) and label → Click Change → Click Old and New Values →*  
| **Old Value** | **New Value** |
| Lowest thru .99 | 1 (less than min) |
| 1 thru 2 (range) | 2 (between min and max) |
| 2.01 thru Highest | 3 (above max) |
| **Step 4:** Run a crosstabs between facility type variable and Variable Y.  
*Analyze → Descriptive Statistics → Crosstabs → (facility type variable) by (Variable Y)* |
| **Sample Syntax** | USE ALL.  
COMPUTE filter_$ = ( managed at this facility variable = 1).  
VARIABLE LABEL filter_$ ‘managed at this facility variable = 1 (FILTER).’  
VALUE LABELS filter_$ 0 ‘Not Selected’ 1 ‘Selected.’  
FORMAT filter_$ (f1.0). |
FILTER BY filter_$. EXECUTE.

COMPUTE Variable A = (no. of months of data available variable* 30) - total no. of days stocked out variable . EXECUTE.

COMPUTE Variable B = Variable A/30. EXECUTE.

COMPUTE Variable C = physical inventory variable / (total dispensed most recent 6 months variable / Variable B). EXECUTE.

RECODE Variable X
(Lowest thru .99 = 1) (1 thru 2 = 2) (2.01 thru Highest = 3) INTO Variable Y.
VARIABLE LABELS Variable Y ‘variable Y label.’ EXECUTE .

CROSSTABS /TABLE S= facility type variable BY Variable Y /CELLS = COUNT ROW /COUNT ROUND CELL.

---

**Indicator 14: Method mix availability on the day of the visit (from a specific product category, e.g., contraceptives)**

**Question to answer**
Is there a stockout of one or more of a specific type of product on the day of the visit?

**What does it measure?**
This indicator measures the percentage of facilities stocked out of one or more products (from a product specific category) on the day of the visit. Method mix availability is also an indicator of product availability.

**How do you get it?**

**Step 1:**
Filter by if facility offers services variable.

*Data ➔ Select Cases ➔ If condition is satisfied… ➔ IF ➔ (offer services variable)=1 ➔ CONTINUE ➔ OK*

*In the OUTPUT box, select “filter out unselected cases.”*

**Step 2:**
Compute a new variable which counts all products of interest (i.e., temporary methods).

*Transform ➔ Count ➔ Provide a new target Variable Name and Target Label ➔ Move all products of interest from “stockout today” category to the Variable Box*
Step 3:
Run a crosstabs between facility type variable and Variable A.

Click Define Variables  
Under Values, write “1”  
Add  
Continue  
OK

Sample Syntax

USE ALL.
COMPUTE filter_\$ = ( managed at this facility variable = 1).
VARIABLE LABEL filter_\$ ‘managed at this facility variable = 1’ (FILTER).
VALUE LABELS filter_\$ 0 ‘Not Selected’ 1 ‘Selected.’
FORMAT filter_\$ (f1.0).
FILTER BY filter_\$.
EXECUTE.

COUNT  
Variable A = product X product Y product Z (1).
VARIABLE LABELS Variable A stockouts of products X Y Z on the day of the visit.
EXECUTE.

CROSSTABS  
/TABLES = facility type variable BY Variable A  
/CELLS = COUNT ROW  
/COUNT ROUND CELL.

Other Indicators

What are they?
Other indicators can include:
- Percent of facilities that manage (e.g., family planning) commodities
- Percent of reports that have reports for (e.g., family planning) commodities
- Percent of facility personnel managing (e.g., family planning) commodities
- How commodity managers learned to complete forms/records
- Supervision visits received by commodity managers

How do you get it?
Generally, remaining indicators will involve filtering by an “if managed” variable and/or running crosstabs. Sample syntax for several remaining indicators is listed below.

Sample Syntax
Percent of facilities that manage (e.g., family planning) commodities
CROSSTABS  
/TABLES = facility type variable BY offer services variable  
/FORMAT = AVVALUE TABLES
Percent of reports that have reports for (e.g., family planning) commodities

USE ALL.
COMPUTE filter$_$ = (offer services variable = 1).
VARIABLE LABEL filter$_$ 'offer services variable = 1 (FILTER).'</n
VALUE LABELS filter$_$ 0 'Not Selected' 1 'Selected.'
FORMAT filter$_$ (f1.0).
FILTER BY filter$_$.
EXECUTE.

CROSSTABS
/TABLES = facility type variable  BY report variable
/FORMAT = AVALUE TABLES
/CELLS = COUNT ROW
/COUNT ROUND CELL.

Percent of facility personnel managing (e.g., family planning) commodities

USE ALL.
COMPUTE filter$_$ = (offer services variable = 1).
VARIABLE LABEL filter$_$ 'offer services variable = 1 (FILTER).'</n
VALUE LABELS filter$_$ 0 'Not Selected' 1 'Selected.'
FORMAT filter$_$ (f1.0).
FILTER BY filter$_$.
EXECUTE.

CROSSTABS
/TABLES = facility type variable  BY person responsible for managing variable
/FORMAT = AVALUE TABLES
/CELLS = COUNT ROW
/COUNT ROUND CELL.

How commodity managers learned to complete forms/records

USE ALL.
COMPUTE filter$_$ = (offer services variable = 1).
VARIABLE LABEL filter$_$ 'offer services variable = 1 (FILTER).'</n
VALUE LABELS filter$_$ 0 'Not Selected' 1 'Selected.'
FORMAT filter$_$ (f1.0).
FILTER BY filter$_$.
EXECUTE.

CROSSTABS
/TABLES = facility type variable  BY way learned to complete forms/records variable
/FORMAT = AVALUE TABLES
Supervision visits received by commodity managers

USE ALL.
COMPUTE filter_$ = (offer services variable = 1).
VARIABLE LABEL filter_$ 'offer services variable = 1 (FILTER).'</n
VALUE LABELS filter_$ 0 'Not Selected' 1 'Selected.'
FORMAT filter_$ (f1.0).
FILTER BY filter_$.
EXECUTE.

CROSSTABS
/TABLES = facility type variable BY last time received supervision visit variable
/FORMAT = AVALUE TABLES
/CELLS = COUNT ROW
/COUNT ROUND CELL.
Reference for Stock Status Table

Column 1: Name of the product  
Column 2: Unit of count for the product  
Column 3: Whether or not the product is managed at this facility, answer Y for yes or N for no. Skip to the next product  
Column 4: Check whether the stockcard is available; answer Y for yes or N for no.  
Column 5: Check whether the stockcard had been updated within the last 30 days; answer Y for yes or N for no. Note: If the stockcard was last updated with a balance of 0 and the facility has not received any resupply, consider the stockcard up to date.  
Column 6: Record the balance on the stockcard.  
Column 7: Record whether the facility is experiencing a stockout of the product on the day of the visit; answer Y for yes or N for no.  
Column 8: Record whether the facility has had any stockout of the product between July and December 2005; answer Y for yes or N for no.  
Column 9: Record how many times the product stocked out between July and December 2005.  
Column 10: Record the total number of days the product was stocked out between July and December 2005.  
Column 11: Record the quantity of product issued from the storeroom between July and December 2005. Note: If the answer to column 4 is No, record NA in this column.  
Column 12: Record the number of months the issued data represent (may be less than six), record the months for which there are any data recorded, including 0. Note: If column 4 is No, record NA in this column.  
Column 13: Record the quantity of product in the storeroom. Estimate to one-quarter of a bottle for open containers of tablets.  
Column 14: Record the quantity of expired products. Count all expired products on the day of the visit. If there are products that are near expiry (within one week), please note in the comments section.

<table>
<thead>
<tr>
<th>Product</th>
<th>Units of count</th>
<th>Managed at this facility?</th>
<th>Stockcard available? (Y/N)</th>
<th>Stockcard updated? (Y/N)</th>
<th>Balance on stockcard</th>
<th>Stockout today (Y/N)</th>
<th>Stockout last six months (Y/N)</th>
<th>Number of stockouts</th>
<th>Total number of days</th>
<th>Total issued</th>
<th>Total of mos. of data available</th>
<th>Physical inventory – Store room</th>
<th>Quantity of expired products</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
<td>12</td>
<td>13</td>
<td>14</td>
</tr>
<tr>
<td>No.</td>
<td>Indicator</td>
<td>Formula</td>
<td>Where do you get it?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----</td>
<td>-----------</td>
<td>---------</td>
<td>---------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Percentage of facilities that manage “X” product</td>
<td># of facilities that manage “X” * 100/Total # of facilities visited</td>
<td>Column 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Percentage of facilities that have stockcard available</td>
<td># of facilities that have stockcard available *100/Total # of facilities that manage product “X”</td>
<td>Column 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Percentage of facilities with updated stock cards</td>
<td># of facilities that have stockcard updated * 100/ # of facilities that have stockcard available</td>
<td>Column 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Percentage of facilities stocked out in the last six months</td>
<td># of facilities stocked out in the last six months * 100/# of facilities that manage product “X”</td>
<td>Column 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Average duration of stockout in the last six months</td>
<td># of days of stockout in the last six months /Total # of stockouts</td>
<td>Column 9 / Column 8.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Average number of days of stockout</td>
<td># of days of stockout/total # of facilities stocked out in the last six months</td>
<td>Column 9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Average frequency of stockout per product</td>
<td>Total # of stockouts *100/ facilities stocked out in the last six months</td>
<td>Column 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Percentage of facilities stocked out on the day of the visit</td>
<td># of facilities stocked out on the day of the visit * 100 / # of facilities that manage “X” product</td>
<td>Column 13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Percentage of facilities where stockcard does not match physical inventory</td>
<td>Balance on stockcard – physical inventory * 100/physical inventory</td>
<td>(Column 6–Column 12) * 100/ Column 12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Months of Stock on Hand (MOSH)</td>
<td>Total # of days with stock available = (Months of stock data available) * 30 – (total # of days of stockout) Months of data available = total # of days with stock available/30 AMC = Total issued/months of data available MOSH = Physical inventory/Average Monthly Consumption (AMC)</td>
<td>Total # of days with stock available = (Months of stock data available) * 30 – (total # of days of stockout) Months of available data = total # of days with stock available/30 AMC = Column 11/Months of available data MOSH = Column 13/AMC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Percentage of facilities stocked between their minimum and maximum inventory levels</td>
<td># of facilities stocked below, at, or above their established max levels * 100/total # of facilities that manage product</td>
<td>MOSH (recoded into categories for those above their min, within the range of max-min, or below their min levels)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Percentage of facilities meeting adequate storage conditions</td>
<td># of storage facilities meeting each storage condition/total # of facilities visited</td>
<td>Storage conditions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Method mix availability on the day of the visit</td>
<td># of facilities that stocked out of a specific product(s) on the day of the visit/Facilities that manage product “X”</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Run indicators for each product; run analysis separately by facility type and by region.
Appendix M

Preparatory Steps for Assessment Organizers
In-country staff should undertake the following preparatory steps:

- Once the data collectors and supervisors are hired, the country office should notify them of the dates, times, and location of the training. Make sure that they are available for the total length of the training and for the duration of the data collection. Training is required for all data collectors and supervisors, regardless of whether they have participated in prior surveys in the past.
- Obtain prepaid mobile phones for team leaders if they do not already have them. If they do have them, find out whether they will need cards for additional airtime minutes or reimbursements for calls related to the survey. If appropriate, purchase additional minutes for all data collectors.
- Prepare a list of contact information for all team leaders, monitors, and program staff cell phones so teams can stay in touch in the field.
- Make arrangements for a room, laptop, and projector for the data collector training. Collect examples of the commodities being assessed. Familiarizing data collectors with the packaging and unit of count of each product will help ensure an accurately counted inventory.
- Make arrangements for a room and computers for the data entry staff to use in their training and for data entry.
- Purchase name tags, pencils, pencil sharpeners, erasers, one stapler per team, one small calculator per team, sturdy bags for data collectors to use to carry their questionnaires, and clipboards for them to write on in the field.
- Purchase manila envelopes for the data collectors to use to organize questionnaires.
- Make sure there is sufficient paper and copier ink on hand for printing the questionnaires or identify outside services that can be used for the printing. Consider whether offsite printing will be needed for the questionnaires. If so, get quotes.
- Check into sources of vehicles to transport the data collectors and study coordinator to the field; get quotes as needed. There should be one vehicle per team and one for the study coordinator and program staff.
- If the training materials need to be translated into a foreign language, the country team should request this in advance or arrange for it to be done locally. Local program staff fluent in local languages should check the translations.
- Team leaders should carry additional funds to cover unforeseen incidents (e.g., vehicle repair).
- Provide per diem for teams based on country-specific protocols and accounting regulations.
For more information, please visit deliver.jsi.com.